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0. Clear your browser’s cache and cockies:

3. 1. Open the Tools menu and select Internet Options.
2. 2. On the General tab, in the section labeled Temporary Internet files, click on the Delete Cookias button and answer OK.
3. 3. Click on the Delete Files button, check the box which reads Delete All Offtine Content and answer OK. (Please note, if you

have not recently cleared your file cache, it may take several minutes for this process (o finish.}
0..Ensure that your browser uses 128-bit encryption for secure connections:

1. 1. Open the Help menu and select About Internet Explorer.

2. ?_Verilymatlhe Cipher Strength value is 128-bit

.. Set secwrity seltings:

1. 1. Open lhe Tools menu and sefect Internet Options.

2. 2. On the Advanced tab, scroll to the Security section and check settings for SSL 2.0, SSL 3.0, TLS 1.0, PCT 1.0.
3..Add Google.com as a trusted site:

1. 1. Open the Tools menu and select Internet Options.

2. 2. On the Security tab, click on Trusted Sites, then dick on the Sites button.

0.3. Add the URL above to the list of trusted sites.
FOR INTERNET EXPLORER (Mac OS X):

0.»Clear your browses’s cache:

1. 1. Open the Explorer menu and select Preferences.

2. 2. Find the section labeled Web B and click on Advanced.

3. 3. Find the section labeled Cache and click on the Empty Now button. (Please note, if you haven't recently cleared your file

cache, it may take several minutes for this process to finish.}
0.» Clear your browser’s stored cookies:

1. 1. Open the Explorer menu and select Preferences.
2. 2. Find the Receiving Fites section and clfick on Cookles.
3. 3. Select all of the items that appear next to this section and click Delete.

0.,Add Google.com as a trusted site:

1. 1. Open the Explorer manu and sefect Preferences.

2. 2. Find the section labeled and click on SecurityZones.

3. 3. Find the drop-down menu labeled Zones and select Trusted sites zone from the menu.
4. 4. Click the Add Sites button.

5. 5. In the window which appears, click the Add button.

6. 6. Enter the foliowing URL: https:/adwords.googte.com/

0.7. Click OK.

FOR NETSCAPE:

.. Clear your browser’s cache and cookies:

1. 1. In the Edit menu, select Preferences and click on the Advanced drop-down menu.

2. 2. Select Cache and dlick on the Clear Cache button. (Please note, if you have not recenty cleared your file cache, it may take

several minutes for this process to finish.) Secondly, in the Tools menu, select Cookie Manager and Manage Stored Cookies. Click on the Remove
All Cookies button.
G.» Ensure that your browser uses 128-bit encryption for secure connections:
1 1. Open the Help menu and select About Netscape.
2. 2. Verify that it supports 128-bit security.
«Set security settings:
0.1. In the Edit menu. select Preferences and click on the Privacy & Security drop-down menu.
U.2. Select SSL and ensure that TLS, SSL Version 2 and SSL Version 3 are checked. FOR MOZILLAFIREFOX (Windows):
U ~Clear your browser’s cache:
1. Open the Tools > Options menu and select the Privacy tab.
2 2. Click the Clear button next to Cache.
a] Clear your browser’s cookles:
1 1. Open the Tools > Options menu and select the Privacy tab.
2. 2. Click the Clear bution next to Cookies.
0. Set security settings:
1 1. Open the Tools > Options menu and select the Advanced tab.
2 2. Scruil o the Security section and ensure that SSL 2.0, SSL 3.0. and TLS 1.0 are ai enabled.
] Add adwords.google.com as a trusted site:
1. 1. Open the Tools > Options menu and select the Privacy tab.
2. 2. Ciick on the Cookies section and then on the Exceptions button,
0.3. Enter http:/adwords.gacgle.com in the text field and click the Alfow button. FOR FIREFOX V. 1.0 (Mac OS X):

Oa Clear your browser's cache and cookles:

1. 1. Open the Firefox menu and select Preferences.

2. 2. Click on the Privacy tab.

3. 3. Find the line labeled Cache and click on the Clear button. (Please note, i you have not recently cleared your file cache, it
may take several minutes for this process to finish.)

4. 4. Find the line tabeled Cookles and click the Clear button.

0. Set secunity settings:

1 1. Inthe Firefox menu, select Preferences.

2. .2. Click on the Advaneed tab and find the Securlty section.

3 3 Click on the Triangle next to Security and verify that the checkboxes next to all of the following are checked: Use SSL 2.0,

Use SSL 3.0, Use TLS 1.0.

-/fadwords. e.cans in/index.py Hulidump=§ (41 of 116)8/2/2005 8:35:12 AM

Please try this troubleshooting checidist of solutions to common login problems.

Correct password? The password field is case sensitive, S0 check to see if you are using the correct capitalization. If you're unsure about or have
forgotten your password, you can choose a new one by clicking Forgot your password? on the AdWords home page.

Extra spaces In login? Our login syslem is space sensilive as well as case sensitive, 5o be carelul not to enter any extra spaces before or after
your fogin information.

050



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 3 of 52

Correct email address? Make sure you're using the email address you provided during the Google AdWords account set-up process. s it possible
you used an altemate address by mistake?

If you have a Google AdSense account, changes in your AdSense login information (emall address and password) will also update your
AdWords login information. If you have recently changed your AdSense login information, please try logging in to AdWords with the updated
information.

If you continue to have trouble logging in to your account, please contact us and provide as much detail as you can, including any ertor
you may be receiving.

It you've forgotten your current passward, you can reset the password for your account online; to protect everyone's security, we dontt retrieve
or emall passwords.

Here's how to reset your password:

1. Click Forgot your password? below the fogin box on the Google AdWords home page.

2. This will take you fo the Password Reset page. Enter your emai address to confinn your identity.

3. Click Enter.

4. You'll be emailed a fink that will low you to temporarily access your AdWords account and fo choose a new password.
Please note that this link will only work once; if you're stil unable to log back into your account, you'll rieed 1o repeat the above steps.

PN

Please note, if you have a Google AdSense account that shares the current login email address of your A changing your
AdWords login information will aiso update your AdSense login information.

it can take 5-10 business days for Google to receive your transfesr. The timing of a given transfer depends on your local bank processes, so
please be patient. if we don't dispiay your funds in your AdWoerds account after at least two weeks,

- Check that the transfer amount has been withdrawn from your bank account. If it hasn't, please check with your bank.
Piease contact us. ) the money has been withdrawn from your bank account. We may then ask you to send us the bank
s!alement lhat includes your bank transfer as a proof of payment. We’'ll then work with our third pany paymem processor to mv&sﬁgale,
- Confirm with your bank that your maney was sent to the curent receiving that was provided in your p m

The AdWords Discounter reduces your actuat cost-per-click (CPC) based on your ad's clickthrough rate (CTR).
From January 14th to February 17th, 2005, we incorrectly predicted the CTR for a small number of ads created
during this pesiod; tharefore, some ads cidn't receive their full discount. We've coirected the problem and credited
the price differance to affected adk . You can see this credit as a line item on your AdWords
account Billing Summary page.

The Google AdWords system is designed to log users off afler a set period of inactivity. it does this to both maximize the speed and efficiency
of the system
and to protect the security of individual accounts.

There are several possibie solutions to this problem. You can reconfigure your proxy so that is do&g not use multiple IP addresses, use a different
proxy, or stop using a proxy server to access the Infemet.

If you are using the Intemet Explorer browser and your session is expiring, please follow the instructions below.

1. With Intemet Explorer apen, dick Tools’ on the top bar.

2. In the menu, choose ‘intemet Options.”

3. Click on the "Connections’ tab.

4. Click on the ‘Settings’ button.

5. Click the *Advanced button.

6. In the box liled "exceptions,’ under ‘Do not use proxy server for addresses beginning with:' type ‘hitps:// (without the single
quote marks). This should allow you to edit your AdWords acoount without session

PNALN-

If this does not work, the firewall for your netwark might be the pmblem. if you are using an HTTP proxy, and that proxy uses multiple IP addresses
when connecting to external sites (like AdWords), then your session will expire every time you access the site.
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Thare may be several reasons why your conversions are not showing in yow reports. Check the following conditions:

0. Make sure Ihanheoonversmn code hasbeenplacedonyourwehste
. - igate to the cor confi ion page on your website.
- Make sure that you can see the Google Site Stats text on that page.
- Check that the conversion code is on the comect page. Remember that you need to place the code on the conversion

conﬁrmahonpage—vmenausaneameshspage meresmumt:er\owaytobad(omhwn\haoomers:on if you put it on a previous page, Google
may report conversions for users who leave your site before i

- Check again after more time has elapsed. Therwonsmaymhavebeenlmoa!edyetvwmyaxcomemon(s) this can
someumes take up to 24 hours.

Our perlc monitor conti 1y revi accounts; if we find that your account has inued Lo experi T e, we will notify you
via email. We will also slow the defivery of ads for your in tial keywords so that you don't have to pay for addlhona! umageled cicks that are unilikely
to convert (o sales. To restore full delivery, edit your ad and keyword list and dlick the Restore Full Defivery button at the top of your campaign
summary page.

Please note that the Google AdWords automated performance monitor will cortinue to review the clickthrough rate (CTRY) of your keywords, so
it your targeting improvements don't work out, you will receive another email. #f you need to restore full delivery a third time, you will be charged
a nominal reactivation fee. Leam more

Here are some common queslions and answers about slowing.

What is slowing? Slowing is our systern’s way of alerting you to keywords which aren't performning well and which may be hampering your
paign's overall effect When our sy determines that a keyword has a very low clickthrough rate {or CTR), your ad will begin to appear
only rarely on has for those key You'l see a2 message in your account lo alert you of this.

What's the point of slowing? Slowing gives you the time to revise keywords so they'll perform better, or to identify and delete keywords that simpty
aren't reaching the audience you want. It also allows you to refine the text of the ad(s) in Ihe canpaign to better match your keywords. To read more
about how to improve keywords and ads for imum perf see the AdWords op tion tips.

OK, V'va revised my keywords. What now? Once you've revised or deleted any underperforming keywords, and reviewed your ad text, click the
Restore Full Delivery button on your Campaign Management page. This wilt return your campaign to nosrnal delivery.

if your campaign continues to pesform poorly we will stow deflivery again to give you more time fo re-edit your keywords and adverti s. A
nominal reactivation fee will be charged for every third time you restore full delivery in this manner.

Why do you charge a fee every third time ] reactivate my account? The reactivation fee exists o encourage you to optimize your .
bafora ing normal delivery. Otherwise, advertisers might simply keep restoring normal delivery with underperforming keywords R
unt) those keywords are disd:led That nesuns in a poor experience for them and for users.

| dont care how poorly my ad performs. Why don't you just tet me run on every keyword | want? AdWords works best for everyone, users and
advertisers aitke, when the ads are highly relevant to the keywords of a search or of a given contem page. Slowing is a way for us to alert you o ads
which aren't highly relevant and probably could be giving you better results. Ultimately, underp g keywords will be comp disabled, so
slowing Is a useful way to help advertisers improve keywords before they reach that point.

For more on the topic of slowing, please visit the Mi CTR and Pes itor page.

View the page source and make sure that you see the conversion code on the page {(marked with a <! - Google ¢ code —> ¢C tag).

To do this, select View > Source in your browser menu.

The Traffic Esﬁmator indudes samples of historical ad performance (for your ads and other ads using similar keywords) in its calculations.

if you see '<0.1' in the Clicks / Day field, the Traffic Estimator has determined, based on this sampling, that your ad will likely not gamer impressions
or receive clicks on any search results page or other ad space. Generally speaking, this occurs when the combination of various factors such as your
smaximum cost-per-click (CPC) and clickthrough rate (CTR) aren't sufficient to eam an ad position.

In this situation, you may wish fo increase your CPC and improve your CTR until you reach your desired results.
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Generally, payments are declined if our billing system is unable to verify the billing information you've
submitted. Here's a troubleshooting checklist of possible causes:

. Incorrect Credit Card Number:
Have you canceled the credit card we have on file for you and not yet entered your new credit card
information?

. Incorrect expiration date:
Please check the expiration date on your credit card. If your card expires, you must update your
AdWords billing information when you receive a new card with a new expiration date.

- Incorrect billing address and phone number:
Be sure to keep your telephone number and billing address current. if the address and phone
number listed in your AdWords account do not match those associated with your credit card, our
system will not be able to process your charges.

. Incorrect business information: Be sure you've selected your Primary Business Type
from one of the drop-down menus on the User Preferences page (under the My Account tab). Your billing
information will be considered incomplete unless you've made a selection.

. Credit limit reached:

You may have reached your daily or total credit card limit on the day we attempted to charge your
card. Your
credit card must have enough available credit to cover your monthly advertising budget. if your card
does not
have enough credit, you'll need to decrease your daily budget, or enter a new credit card with a
higher credit
limit. You may need to contact the issuing bank to determine the credit limits on your credit
card. You can update your billing information at any time. If you still cannot successfully submit your
credit card information, contact the card-issuing bank for detalls about why they have declined the
particular transaction.

Google AdWords advertising is separate from and unrefated to the ranking and inclusion of your site in Google's search results. For more information
about how websites are listed in our search results, please visit our Webmaster FAQ.

When you access the Traffic Estimator and analyze your keywords, you'll see, among other information, the
approximate ad position and number of dicks you might receive each day. By simply increasing your maximum
cost-per-chick (CPC), you can often improve your results. However, you may encounter situations where
ncreasing your CPC has Fittle effect on your estimates. This may ocaur for the following reasons:

Historical ad perf

The Traffic Estimator includes samptes of historical ad performance (for your ads and ofher ads using similar
keywords) in its calculations. If the overall clickthrough rate (CTR) for this samgling is consistently low, you'll
see lower click estimates reflected in the displayed estimates. in this situation, you may wish to improve your
CTR, which will, in turn, Increase your estimates in the future.

Query analysis

In order to provt traffic esti the AdW rste itors keyword and search query
patterns. Any low estimates you receive may be due to a Iack of queries for your spegcific keyword or keyword
phrase.

n this situation, you may wish to fry different keywords or keyword combinations. To do so, please access
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our keyword tool. {(You can also getideas for additional keywords by clicking altarnate keywords to the
right of your traffic estimates.)

Google Network policies

Search and content partners on the Google Network have different policies goveming what types of ads may
appeas on their pages or products. For example, some search and content partners only accept family-safe ads.
The traffic estimator accounts for these policy variations among Google Network partners, and displays estimates
accordingly. Therefore, white advertising on the Google Network can increase your exposure to new qualified
prospects, you may not necessarily see a significant change in traffic estimates.

EE-_”M gggﬂtwm/ mnlbmﬁndq.m?ful\dmfl {44 of 116)372/2005 8:35:12 AM

The Traffic Esti il les of hi: al ad performance (for your ads and other ads using similar keywords) in its calcutations.

1 you see a *-' instead of a numeric value in the Position field, the Traffic Estimator has determined, based on this sampling, that your ad will likety not
gamer impressions on any search resuits page or other ad space. Generally speaking, this occuss when the combination ef various factors such as
your maximum cost-per-click (CPC) and cfickthrough rate (CTR) aren't sufficient to eam an ad position.

In this situation, you may wish to increase your CPC and improve your CTR until you reach your desired results.

1 your web browser blocks cookies from Google.com, you may experience difficulty staying logged in to your Google AdWords account. To allow
cookles from Geogle, follow the instructions below.

In Intemet Explorer

1. 1. Click on the Tools menu and select Intemet Options.

2. 2, In the resufting dialog box, select the Privacy tab and click on the Edit butfon near the bottom of the window.
3. 3. Inthe fieid labeled Address of Web site enter ‘google.com’ (without the quotes).

0.4. Click the Allow button followed by OK until you return to the main br d In N pe:

1 1. Click on the Tools menu, select Cookie Manager and "Manage Stored Cookies.'

2. 2. Click on the Cookie Sites tab.

3 3. In the field labeled Manage sites that can... enter ‘googie.com’ (without the quotes).

D0.4. Click on the Allow button folowed by Close to retum to the main browser window. In Mozilla Firefox:
1. 1. Cliick on the Tools menu and select Options.

2 2. Chick on the Privacy icon and select Cookies.

3 3. Ciick on the Exceptions button.

4. 4. in the field labeled A of ite enter ‘google.com’ without the guotes.

5. 5. Click on the Allow button followed by OK until you retum to the main browser window.

Recent changes to the AdWords keyword evall may affect reports you ereated previcusly in your Report Center. The keyword states
‘strong,’ ‘moderate,” ‘at risk,” and *slowed” were phased out as part of our ongoing efforts to str line our keyword evaluation process and help our
users find exactly what they’re looking for.

Because of this change, some older scheduled and on- reporis will no longer retum accurate resuits. For example, if your regularly-scheduled
report included 'at risk’ keywords as a parameter, that report won't run propetly because “at risk’ keywords no longer exist.

Here's how to see which of yours reports may have been affected:

1. 1. Log in to your AdWords account.
2 2, Click the Reports tab al the top of the page.
3. 3. Click Download Center on the Reports tab.

Any reports affected by this change will be marked with a notification alert at the top of the page. We recommend that you create entirely new reports
based

on the new keyword states, and delete the affected reports.
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To create a new report: v
1. 1. From the Download Center, click Create Report on the Repaorts tab at the top of the page.
2 2. Select a repont type from one of the options to the left, click the link, and follow the instructions to create your new report. We apologize

for any inconvenience this may have caused.

Helpful Links

« MOF€ wos ragom.
& MOre et emartar byt onbimion.
@ MOTE it 0 mane Lo st

aglaye onte. e fokowing comee:

«if you request data for a time period that goes beyond tiwee months piior to today's date.
=1 no changes were made to your account for the time period that you selected. We're working to make
more information avallable to you, and we appreciate your patience in the meantime.

dex.py?fulldurop=1 (45 of 116)8/2/2005 B:35:12 AM

The feature you're trying to is temp y ur ilable due to routine system maintenance. We expect lo complete this maintenance within 24
hours. Please check back at that ims.

We apologize for any inconvenience this may cause.

My ads are live—now what? : Troubleshooting my account : Troubleshooting my ads

The Ads Diagnostic Tool can repost the ad position for active keyword-targeted ads, and identify why a particular ad or group of ads may not be
showing. In those cases where an ad is not shown, this tool provides recommended steps to help you get your ads up and running.

You can access the tool via the following steps:

1. 1. Log into your AdWords account.

2. 2. Click Tools b th the Campalgn Manag, tab.
3. 3. Click Ads Diagnostic Tool.

4. 4. Enter information for either Option 1 or Oplion 2:

Option 1: Search Terms and Parameters

Use this option if you're concemed about all ads within your account that should be appearing for a specific search term. Specify the
keyword query, the Google domain, the display language, safe search sefting, and user location.

Option 2: Search Resulits Page URL

Use this oplion if youre concemed about a particular search results page that you believe should be showing one of your ads. Copy and
paste the URL from the address bar on the search results page where your ad should be shawing.

5. Qlick Continue when you are finished, Site-targeted ads can't be diagnosed with this too! at this time.
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The Disapproved Ads tool within your AdWords account allows you to easily check the status of your disapproved ads and find out why they were
disapproved. You'll still receive emails from our AdWords Specialists regarding all disapproved ads; however, this tool wilf also be available for you to
review your ad disapproval status at any time.

Wrth.mls tool, you'll be able to review the ad, its focation, the raason for disapproval, suggestions from ow AdWords Specialists, and the date your
ad was disapproved. At this ime, the tool does not reflect the status of approved or pending ads, or keywords for your account.

To access the Disapproved Ads tool. please do the foliowing:

1 1. Log into your AdWords account.

2. 2. Click Tools’ on the Campalgn Management lab.

3. 3. Click Disapproved Ads under the Analyze Your Ad Perdformance section.

4. 4. To edit an ad, click the Edit ad link in the far right-hand column. You'll be able to edit your ad from its comesponding Ad Group; once
you save your ad, it wil automatically be submitted for review by our AdWords Speclatists.

Tips:
-Click Details in the Disapproval Reason column to leam more about why your ad was disapproved.

- M your ad belongs to a paused or deleted campaign or Ad Group, this status wifl be included in the Campaign or Ad Group columins. In this case, you
won't be able to make edits. However, you can click ‘View ad" to review the ad text.

-To remove ads from this page (but not actually remove them from your account), use the Ignore function at the top of the table. You can also use the
drop-down box to view disapproved ads for: Show afl campaigns, Show only active campaigns, Show &l but deleted campaigns.

1. Check your ads. They must adhere to our Editorial Guidelines. Ads will not run on the
Google Network until they've been revnewed by our AdWords Specialists, so please ensure that you meet
the standards in the

Editorial Guidelines. You may notice your ads appearing on Google before they appear on ACL or
other network sites because of this review process. To leam how to edit your ads, click here.
2. 2. Increase your daily budget. if your ads qualify for the Google Network, you can expect
more people to see your ads and more clicks to come your way. Make sure that you get the exposure you
want by increasing your

hitps://adwords. google.conv feinvindex. py Hulldump=1 (46 of 116)8/2/2005 8:35:12 AM
daily budget. Increastng your daily budget maximizes the number of impressions your ads receive. To
leam how to increase your daily budget, click here.
1. 3, Increase your maximum cost-per-click (CPC). The position of your keyword-targeted
ads is determined by various performance factors including: maximum cost-per-click (CPC), clickthrough
rate (CTR), and ad text. You may want to increase your CPC to help improve your ad's position. AOL only
displays the top three Google AdWords ads on any given page, so raising your CPC increases your chance
of consistently appearing on all advertising network sites. To learn how to increase your CPC, click here.
2. ’y Increase your clickthrough rate (CTR). As mentioned above, your ad’s position is partly
determined by your CTR, so be sure your ads are optimized and ranked high enough to appear on AOL.
You can increase your CTR by refining your ad text, using keyword matching options, and using the
keyword toof to refine your keywords. To leamn more about how to increase your CTR, visit our Optimization
Tips page. You can also learn how to proactively monitor your keywords.
3. 5. Increase your maximum CPM. If you're running site-targeted campaigns with cost-per-
impression (CPM) pricing, increasing your maximum CPM should increase your visibility on the Google
Network. To leam how to increase your CPM, click here.

4. 6. Check your distribution pteference. Make sure you haven't already opted out of the
Google Network. To leam how, click here.
5. 7. Finally, some Google Network partners may restrict advertising based on their own

policies regarding content. As a result, one or more of your ads may not appear on these sites.

The suggestions supplied by the Ads Diagnostic Too! were compiled based on our ongoing support experience with advertisers within the program.
While these Jations are gt fly applicable to all advertisers, we understand that you may stil experience some difficulty getting your ad
up and running after following lhese suggestions.
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Please conlact our support team and we'll be happy to assist you with your account. in your message, pfeass include a list of the ad{s) and keywords
you are concemned about, and include the campaign name and Ad Group where each is located. An AdWords Specialist will research your concemy(s)
and contact you with reasons and solutions for your particutar case.

The Ad Diagnostics todk reviews data specvﬁc 10 each query and its related ad(s) based on all available account data at the time you run the ad
diagnostics report. Like the statistics a for your igns and Ad Groups, reporting is not real-time and may not reflect data received in the

paly

last three hours. Please note that using this tool will not generate additional impressions for your ads.

if there are other factors within your account affecting the query and ad diagnosed, this information wilt be included in the diagnostic results. Details
that may impact your ad defivery for a particular query will only be included from active campaigns, Ad Groups, and keywards. Currently, the data
reviewed is specific only to those ads you have targeted to the Google search network.

Reported issues for a particular ad and its related keywords may include any aspect related to ad creation and your account settings. Examples
include ad and keyword approval status, cost-per-click (CPC) and budget price settings, ad and keyword performance, ranking status, geo-targeting
settings, etc.

Sometimes we're unable to obtain intemet protocol (1P} information for some searchess, especially those using intemet service providers (ISPs) that
employ proxy servers. B we can't dk ine the her’s location in these cases, we'l show nationally-targeted ads instead of regionatly-
targeted ads.

AdWords billing & payments

i CRC.vasy by Gcaion’?

You assign a maximum cost-per-dick (CPC) for each Ad Group and/or keyword in youwr AdWords account. Similar
10 bidding in an auction, the maximum CPC ybu enter should be the most you are willing to pay per dlick. Likely,
you'll pay less-we adjust your price per click based on your nearest competitors. The lowest amount you could bid
and pay within the AdWords pricing model is the minimum CPC, which varies based on the country in which your
ad is shown. To ieam more about the minimum CPC in your target location, visit our form of payment tinder.

There are two possible minimum CPC amounts:

Glabal Minimum CPC: The minimum CPC required to potentially show your ads in all AdWords target
countries. The minimum CPC may be lower in certain locations (Jlocal minimum CPC).

Local Minimurm CPC: A reduced, location-specific minimum CPC for ads targeting China and Poland, and for
advertisers with biiling addresses in China or Poland. Only these advertisers can enter the local minimum CPC
as the maximum CPC for an Ad Group.

Keep in mind that selecing the local minimum CPC as your d CPC may pi your ads from
showing in all of your chosen target countries. To show your ads in countries other than China and Poland
you must bid at least the globat minimum CPC.

tp google.com/support/bin/mdex py2fulldump=1 (47 of 116)8/2/2005 8:35:12 AM
As always, the AdWords Di will automatically adjust your CPC to the mini t needed fo maintain your ad's pesition. That means,
based on the location of your customer, you may stifl pay as little as US$0.02 to show your ad.

Here's an exampie of how these two minimum CPC values work:

Your bilfing address is in China. and you set up 2 campaign that targets China. Bacause China has a local minimum CPC, you can enter bids as low
as USD $.02 per dick. Suppose you then change the country targeting of your campaign to include the United States. To target the US, you will need
to bid at least USD$.05 in order for your ads to show. It is still possible that you will pay as kttle as USD$.02 per dlick from users located in China
because the Advords Discounter will automatically adjust your CPC based on the location of the user.
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AdWords billing & payments : My billing address is in the European Union

R B

Yes. As of July 1, 2003, all AdWords accounts with European Union (EU) business addresses became
subject to Value Added Tax (VAT) charges. In addition, as of January 22, 2004, all EU advertisers moved
from being an advertiser with Google Inc. (United States headquarters) to being serviced and billed by
Google lreland Ltd (EU).

Advertisers with a business address in the EU, but outside of Ireland, may self-assess VAT at their Member
State’s local rate if they are using Google AdWords for business purposes.

How'851 provida Goopld i s valid VAT fljitber?

New advertisers are asked to provide VAT information during the account set-up process. If you're a current
advertiser and already registered for VAT in an EU Member State, please follow the steps below to update
your VAT information:

.Log in to your AdWords account.

.Select the My Account tab.

.Click Billing Preferences (Jocated just below the tabs).
.Locate 'VAT Information’ and click Edit. :

.Fill out the fields in the VAT Information section.
.Click Save Changes.

Ho i KWty afartoers Rt INATY

Online Advertisers: Irish Billing Addresses

Google Ireland Ltd. charges your account at the current Irish VAT rate, so you do not need to self-assess
your VAT charges. Please note that the Irish VAT rate is subject to change per the lrish govenment's
discretion.

If you do not provide Google with a valid VAT registration number, Google will still charge your account,
including the initial activation fee, at the current irish VAT rate. Please note that the irish VAT rate is subject
to change per the Irish government's discretion.

Online Advertisers: EU Billing Addresses (Outside of Ireland)

If you use Google AdWords for business purposes and have an EU business address outside of Ireland, you
may self-assess your VAT charges at your EU member country rate. Google will not add VAT to your costs if
you declare that you use Google AdWords for business purposes, and your business address is in the EU
but outside of Ireland. You can learn more about EU VAT registration at: http://europa.eu.in/

If you do not declare that you use Google AdWords for business purposes, Google will charge your
account, including the initial activation fee, at the current Irish VAT rate instead of your EU Member State's
rate in accordance with Irish VAT regulations. Please note that the Irish VAT rate is subject to change per
the Irish government's discretion.

We und d that online tr: i quire trust. In particular, we take biling and credit card security very

seriously. i you have refund or credit requests
or concems about your account charges, whether they're related to security issues or not, please let us know.
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However, because email is not a secure means of communication, please do not email us your credit card
number or account password. We should be able 1o resolve the issue without this information. Please do provide
us with your account’s emall address and as much other information as possible regarding the matter. An
AdWords Specialist will review your email and work to reach a solution as quickly as possible.

if you contact us with a bitling concem, we ray temporanly suspend your ads so you don't accrue further
charges. We may also suspend your ads if we have trouble processing charges for youlr account.

In order to reactivate the account, we ask that you please re-submit or update yowr payment information
in order to process your charge. Once we've processed your payment, your campaigns wit
automatically be re-enabled.

ds.google. bin/index py? 1 (48 of 116)8/2/2005 8:35:12 AM
Refunds (it any) are at the discretion of Google and only in the form of advestising credit on www.google.com. Plsase contact your credit card
issuer for information on additional fights granted to you as part of your cardholder agreement.

R

For technical questions about VAT registration in EU Member States or VAT reimbursements you should
consult your tax adviser.

For general questions about how VAT affects your Google AdWords account, you can Contact us.

AdWords billing & payments : AdWords account costs

With cost-per-click advertising on AdWords, the cost of your campaigns really depends on you — how
much you are willing to pay and how well you know your audience. It all boils down to knowing your own
goals and letting us know what they are.

Set your own limits: ‘There is a nominal activation fee for Google AdWords. After that,
you tell us how much you are willing to pay per click and per day. Please click here for more information on
selecting your CPC and daily budget.

. Start smart: Don't bid more than you can afford. If you are unsure what to pay per click to
acquxre a new cusiomer, we help you by giving you cost estimates, specific to your campaign setlings,
during the sign up process.

. Grow from what works: Once you know what works, you can start to build more
campargns and Ad Groups to attract your potential customers. In addition, keyword-targeted ads earn their
position based on various performance factors including: maximum cost-per-click {CPC), clickthrough rate
{CTR), and ad text. With a strong performance history, you could end up paying less to maintain the position
of your ads.

Pay less for more results: Keep in mind that because of our AdWords Discounter and
dynamlc rankmg system based on various factors such as CTR, CPC, and ad text, your actual cost-per-click
(what you actually pay per click) is often less than your maximum CPC {what you are willing to spend per
click) and often decreases when your ad starts to perform better.

In addition to daily budget, maximum cost-per-click (CPC), and performance, which directly control
your costs, keywords and targeting are important factors to consider.

Keywords: We suggest you start off with just a small list of strong keywords and a few
drfferent targeted ads. This will help save you money by reducing the number of untargeted clicks, which are
unlikely to convert to sales. Using keyword matching options also helps you manage your costs by limiting
your ads to the most relevant searches and content pages.

. Targeting: Your CPC is based on what your nearest competitors are willing to pay, so
targeung your ads to your specific market ensures that you are competing in the right market and paying
only what you need to pay. Effective targeting is accomplished through keywords, ad text, and language and
country targefing seftings.
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To increase the daily budget for an ad campaigin

Log in to your AdWords account.

In the Campaign Summary table, select the checkbox(es) next to the campaign(s) you wish to edit.

Click Edit Settings n the header row of the tabie.

Enter the new t(s) in the Daity Budget fiekd(s) on the left side of the Edit Campaign Settings page.
Chck Save All Changesa the ¢ top or bottom of the page.

Note: Your daily budget applies to individual 1 not your total advertising spend. For ple, if you have three ad campaigns, each with
US$5.00 dally budgets, your maximum daily adverhstng spend would be US$15. 00

Google believes strongly in providing high quality and relevant advertising to our users. so Google AdWords does
not rank ads solely on cost. There is no way to reserve top placement in the AdWords program.

hutps:Hadwond: Je.com/: ndex py? (49 of 116)8/272005 8:35:12 AM
Ad placement Is based on a combination of various factors such as your maximum cost-per-cfick (CPC — how much you are willing to pay per dick),
clickthrough rate {CTR -~ ratio of clicks to how many imes your ad was seen), and your ad text. This means thak if you eam a higher CTR with berer
quality eds, you can be rewarded with a lower actual CPC. Our system monitors your compelition and pesf e and autc ly you the

least amount possible.

Your ads begin running and accruing costs only after you activate your account. When you are ready to activate your account, lag in to your accoumt
and submit your biling information. Your ads will then appear on Google almos! immediately. Youl only be billed after one month or after you reach
your first AdWords credit limit.

Choosing a maximum cost-per-click

The pre-filled amount highlighted in blue is our recommended maximum cost per click (CPC). Matching this
amount ensures maximum ad exposure and dlicks for all of your keywords. Once you have decided on a
maximum CPC, click 'Calculate Estimates.’

Assess your cost, click, and position estimates

The Traffic Estimator retums estimates of how much you might pay per day for the keywords you have
chosen. In this example, the average cost per day is US$16.14 with an average CPC of US$1.62. You'l also
see the average position of your ad. Here, the average position is 1.5.
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Chicase cufrency and maximurm costper-ick

You may decide that the Traffic Eslimator predicted too many or too few dlicks at too high or low a CPC. If
$0, you can enter a new maximum CPC in the maximum CPC field and click 'Recalculate Estimates.’

You'll now see a new list of estimates. In this example, lowering the maximum CPC to US$1.50 from
US$2.41 resulted in an average CPC that was, on average, US$$0.86 lower. However, the average position
dropped from 1.5 to 2.3 and the average clicks per day dropped as well.

If cost is more important to you, you may choose o go with this recalculated option. if position and
exposure are more important, you may try option 1.

You can cancel your Google AdWonrds account at any time by pausing or deleting all Ad Groups (or campaigns)
within your account. Or email the AdWords
staff using our contact us form. We'll process your request and send you a confirnation email.

Once you cancel, your ads will stop running and no new charges will accrue to your account However, we will process any pending charges
generated between your last billing and the date your cancelath st was p d. As a result, you may see charges appear on your Billing
Summary page after you cancel. Because our billing cycle is 30 days. you may not be billed for those final charges untll a few weeks after you cancel.

Youll be able to reactivate yow account easily at any tme In the future. To do so, just log back nto your account and foliow the prompts o re-
establish your AdWords advertising senvice.

With Google AdWords cost-per-click (CPC) pricing, you pay only when someone dicks on your ad. Click here for more information about sources of
legitimate clicks.

If you suspect that your ads have been affected by invafid dficks, click here to leam more about AdWords click quality.

‘We recommend daily budgets based on histosical data for the same or similar keywords as you. We also consider additional factors-such as variations
in language and location and Google Network activity.

The daily budget we recommend will ensure your ads appear for all relevant searches, increasing your visibility and reach to potential customers.

Remember, selting your daily budget to the amount we recommend is optional-you're atways m full controt of yous AdWords account. You can edit
your campaign’s daly budget as often as you'd tike, and to whatever amount results in the most approp retym on | for you.
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There Is no fee to nun your ads on sites and products in the Google Network. Ad distribution is an added benefit of the Google Adwords program,
and your ads are automatically eligible.

As with all Google advertising, you only pay for dicks on your ads. You controf how much you spend by selecting a maximum cost-per-click (CPC)
and daily budget that fit your advertising goals. For more information on AdWords pricing and billing, ptease click here.

Because ads targeted to content pages are based on the same set of keywords as used in search, the same maximum CPC that you set for your ads
also appfies for ranking your ads on content pages. Akhough the average CPC that you pay for contextual advertising may differ from search
depending on your competition, you only pay for clicks that you receive, and you will never pay more than your maxinum cost per click.

Google shiows your ads evenly over time so that you reach your daily budget by the end of each day. This keeps your ad from accumutating charges
eaity on and then p ing for the ] of the day.

Once you've selected your keywords, you'll see a recommended daily budget. If you set your daily budget to this value, you will maximize your ad’s
visibility and activity. if your dailly budget is lower than the recommended amount, Google will deliver your ads evenfy throughout the day to keep
your costs at or below your daily budget. Click here to leam how to view and edit your dally budget.

No. With Google AdWords, you don't have to worty about his. You can simply set the same maximum CPC for all your keywords, knowing that the
AdWords Discounter will charge you the lowest CPC you can be charged while still maintaining your position for each keyword. if you want to assign
different CPC values to different keywords, you can simply set up separate Ad Groups with different maximum CPC amounts. You can also use our
power posting feature

to assign a different CPC to each of the keywords within an Ad Group.

Other advertising programs require customers {0 specify a set price for each keyword. This means their cisstomers not only spend more money than
necessary, but also must invest a significant amourt of time palrolling their keywords in order to reduce costs. For example, if you had set a cost-
per-dick (CPC) of US$0.91 in order to appear in the top spot, and the advertiser in the second position reduced his or her price trom US$0.90 to
US$0.70, you would be paying US$0.20 more than necessary to mainaln your position. ’

At this time, the direct debit payment option is only avail: to AdWords adverti; with bank accounts in certain countries. When you select this

payment method, you authorize Google, Inc. and/or its affiiates and their repr bank or pay it processor to submit appropriate charges to
your bank for deduction from your bank aceount for services rendered via your Google AdWords account. Google may submit charges without specilic
notification or confirmation in advance of the charge request.

If you have any other payment concems, please Contact us. One of our dlient service specialists would be happy to answer your questions.

Google AdWords is designed to give you the power to
performance. B alf are seif- ged, it is our advertisers' responsibility to ensure that the

all aspr of your i for imum

ey

destination URL in each ad Is accurate. Also, if an advertiser’s website is unavailable, the advertiser is free to
pause or delete any campaigns for that site.

htps:/fadwerds.google. pporbin/index py? 1(51 of 116)8/2/2005 8:35:12 AM )
By agreeing to participate in the AdWords program, an advertiser provid sthorization for charges. You can view the AdWords Terms and
Conditions for more information. e

No. Image ads pricing is the same as text ads pricing. For keyword-targeted ads you may choose a
maximum cost per click (CPC) of from US$0.05 to US$100.00. For site-targeted ads you may choose a
maximum cost per thousand impressions (CPM) of from US$2.00 to US$100.00. Your daily budget can go
as high as you like. You may change your amounts within these ranges at any time, and there's no minimum

062



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 15 of 52

spending commitment.

Over the course of a single day, you may change your daily budget for each campaign in your account a maximum of ten times. Please note that we

reserve the right to exercise owr discretion regarding ive changes to daily budgets.

if you created your AdWords ads yourseif, you were asked 10 set a dally budget when you sighed up. To alter your monthly spending, follow the steps
listed below to reset that daily number.

1f you used Jumpstart to create your AdWords campaign, you were asked to specify a monthly budget The Jumpstart team divided that number by
30 to detenmiine your daily budget. To change your monthly spending, just revise the daiy budget numbes using the steps below.

1. 1. Log in to your AdWords account.

2. 2. Click the name of the campaign you wish to rebudget.
3. 3. Click Edit Campalgn Settings.

4. 4. Set your new daily budget.

5. 5. Click Save All Changes.

for more detadls, see How do | choose my daily budget?

Yes. Remernber, image ads are priced, targeted, and ranked in the same manner as AdWords text ads.

AdWords billing & payments : Payment options

Google AdWords currently accepts major intermnational credit cards, debit cards, direct debit, and bank transfer payments. Payment options available
depend on your country and cumrency. Visit our payment options page to view al options currently offered.

Please note that the most widely available method of payment is by credit card, such as MasterCard and Visa, accepted infemationally, and debit
cards. In certain countries where credit cards are not widely used, we also offer direct debit and bank transfer payment methods. Depending on the
payment method that suits your locale, you may also have the option to pay for your advertising prior to receiving clicks or impressions (prepay) or
afterwards (post-pay).

-Post-pay allows you to pay only after you accrue charges. Your ads run almost immediately after you submit your billing information.
When you
activate your post-pay AdWords account by submilting your billing information, your ads start sunning. You are then given an initial credit
limit that allows your account to run before you pay for any of the activity your ads receive. You are then charped every 30 days or after reaching your
credit Bmit, whichever comes first if you reach the credit fimit within 30 days, we will charge you and ralse your credit limit
Prepay allows you to pay in advanceolmoeiwng any activity. As you accrue advarﬁsmgcham&s we deduct the cosl from
your prepald balance. Your ads run almost i diately after we ve your p . If your t runs out of funds, your ads will stop running

unfil you make another payment, so be sure to regulaﬂy check your account balance_ To help you keep your account balance up-to-date, we'll email
you when your funds run low and when your balance draws down 1o zero.

To make a payment, please follow these steps:

1. Log in to Your AdWords account.

2. Click ‘Make Payments' under the *My Account’ tab.

3. Enter the amount of money you would like to pay into your AdWords account.

4. Click the "Go' button to generate a one-time reference number and transfer information form with ail of the important
rformation you'll need to inftfate a bank transfer.

B@hm

5. 5. Print or copy down the reference number and additional transfer information provided.

6. 6. Use the transfer information to infliate a bank transfer from your country. Please be sure 10 incluide your reference number.
We will not be able lo process your paymenl without the reference number.

7. 7. When we receive the funds and reference number, we' send you an emall and your ads start running (or continue running if

you are refreshing your prepay baiance).
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Plaase nole that it may take up to ten business days for the fund's to reach your AdWords account.

When you sign up for AdWords, your account will be structured so that most pay ts happen automatically via credit or debit card.

Google AdWards ty pts major intemnational credit cards, debit cards, direct debit, and bank fer pay i Y options
depend on your country and currency. If you do choose a prepayment option (such as bank fer or, in G y. Bankeh -g)youwmneedto
make payments. See How do | make a bank payment? for more nfol i

To leam more about all forms of payment, see What are my payment options?

Yes. For the amount in your currency. please visit our payment options page.

Once you set up your account and select the currency in which you'd like to be billed, it is not possible to
switch to another currency. Please note that the currency you select applies to both billing and payment.
That is, if you select US dollars, payment will be requested and accepted only in U.S. dollars. if you would
like to change currencies, you will need to close your existing account, and create a new account with your
preferred currency. It is important that you dose your initial account to remain in compllanoe with AdWords
Terms and Conditions.

To improve the overall AdWords billing experience, we're upgrading AdWords accounts to a new billing
system over the next few months. As a result of these upgrades, post-pay advertisers may switch back and
forth between available forms of payment (Master Card to Visa, for example). Please visit:
https//adwords.google.com/select! AfpoFinder to view your options.

We look forward to providing you with more payment change options in the future.

First, be sure to review all available payment options. in an effort to accommodate all potential advertisers,
we provide as many options as possible. Once you know what is available to you, you can decide what
makes sense for you.

Here are facts to consider when making your decision:

0. If you prepay for your account...

. Your ads don't start until we receive your first payment. It may take a couple of weeks for
us to receive your payment if you prepay by bank transfer.

. We'll stop running your ads if you run out of funds.

D.. If you sign up for post-pay...
- - Your ads will start running on Google almost immediately

. We'll stop running your ads if we can't process your payment. Remember to keep your
payment information up-to-date.

Post-pay advertisers may switch back and forth between available forms of payment
(Master Card to Visa, for example). Please visit: https://adwords.google.com/select/AfpoFinder to view your
options.

. It isn't possible to change from bank transfer to credit card, or vice versa.

. Always send the payment reference number with your fund transfer. This number is
the only way we can associate your payment with your account. /f you transfer money to us without including
the reference number, there is no guarantee that we will be able to apply the funds to your AdWords
account. You must generate a new reference number for each payment you make. If your bank transfer form

064



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 17 of 52

does not have a field for a reference number, please enter the number in front of or instead of your name.
Google may not be associated with the name of the bank account to which you are
requested to send your money. Google has parinered with a trusted third party to process bank transfers.

- Bank transfer is not a universally available payment method nor is there a
standard’ zed procedure for all banks. Even banks within the same country may have different procedures
for initiating a bank transfer payment.

. - Your bank may charge you a processing fee, which will be in addition to the amount
you send Google.

hips://adworde.google. fan/index. py?fulld 1(53 of 116)8/2/2005 8:35:12 AM

Google does not relmburse adverusers for any bank-imposed processing fees. If your bank imposes a fee
or is unable to complete the transaction, another local bank may be able to provide more suitable options.

. It can take 5-10 business days for Google to receive your transfer. The timing of a
g1ven transfer depends on your local bank processes.
. Check your prepaid account balance regularly to make sure that you don't run out of

funds Make more payments as needed. When your Google AdWords prepayment balance is running low
(approximately 7-10 days worth of funds remaining), we'll email you to give you a heads up to make an
additional payment. It's possible that your account will run out of funds sooner than 7-10 days from the time
we email you, depending on your ads’ activity. If your balance hits zero before your payment reaches us, our
system automatically stops showing your ads until you make another payment.

SedGmSt

Some advertisers may have the option for billing based on credit terms and monthly invoicing. Typlcally,
these advertisers will have an established payment history for at least three months with the Google
AdWords program, and meet our minimum requirements which vary by country.

In order to provide credit terms and monthly invoicing, you must first submit a credit application for review
and approval by Google. In some cases, our finance team will request additional financial documentation
from you for further consideration. Should Google approve and offer you the billing option of credit terms,
you will then need to respond to the email in which you are offered our credit terms billing option. Credit
terms are determined at Google's sole discretion. Once you respond to accept the credit terms offered,
your account will then be switched from credit card billing to credit terms within 48 hours.

Please note that with the credit terms option, you agree to pay the full balance of your account upon receipt
of each monthly invoice. Under these terms, Google reserves the right to suspend or close down your
AdWords account if the following occurs: Google does not receive your payment within 15 business days of
the monthly invoice date, and/or you exceed your monthly credit limit. If Google has reason to believe that
you cannot continue to meet your financial obligations under credit terms, Google has the right to cancel
your participation under this billing option. Once you are approved for a maximum credit limit per month, you
are responsible for paying Google up to this maximum credit limit should you spend that amount on
advertising. Finally, you are solely responsible for maintaining your AdWords program accounts, daily
budgets, and daily spend levels.

You can request a full refund of your remaining prepaid balance contacting AdWords Support. Once we
receive your refund request, we will stop running your ads and email you a confirmation that we have
begun processing your refund.

Because our reports are not real-time, there may be outstanding advertising charges that have not yet
shown up in your reports at the time of your refund request. We will deduct these charges from your
account balance before processing your refund.
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Once your refund is processed, your AdWords account balance is set to zero, and all remaining funds in
your AdWords account are refunded to your bank account. We will send you an email when the refund has
been processed and fet you know the final refund amount after deducting any outstanding costs for
advertising activity. After the refund appears in your AdWords account, you can make another payment at
any time should you choose reactivate your account.

If you are having difficulties with AdWords, you can pause your campaigns on your own and contact us. We
are more than happy to work with you to help you resolve your problems without closing your account. You
are important to us, and we strive to insure that your experience with AdWords is a positive one. We value
your feedback and would appreciate any suggestions you have for us.

There is never a minimum spending commitment to run AdWords ads. There is an
activation fee for all AdWords accounts, and prepay has a minimum payment
limit. Beyond that, you have complete control over the maximum you want to
spend per click or impression, and per day. This is the same no matter how you
choose to pay for your advertising. You don't need to pre-qualify. You have the
freedom to decide if you want to choose prepay or post-pay for your AdWords
account. For more details on payment options and associated costs, please visit
our payment

ions

To ensure that Google successfully receives your bank transfer payments, we recommend that you
follow these guidelines:

Payment reference numbers

. In some countries, a bank may ask you to fill out a form to initiate your bank transfer
payment Please write the payment reference number on this form. If there is no field in which to include this
number, simply write the number in front of your name on the form.

. When sending a payment to Google, please use only one unique payment reference
number per payment. For multiple payments, you must use a different payment reference number for each

payment.

. Include the unique payment reference number provided by Google along with your payment.
If you are using a bank to send your payment, make sure that the bank includes this
payment reference number along with the payment.

Banks and bank transfers

. Due to the way the local banking networks are set up in some countries, you may
expenence limited coverage. This means that not all banks will be able to send a bank transfer payment to
the Google-specified bank account in your country. You may need to contact several banks before finding
one that can send a bank transfer payment.

Please note that the exact procedure for initiating bank transfers may differ depending on
your oountry Even within the same country, different banks may use different procedures for initiating bank
transfers.

. Please note that most bank transfers are 5-10 days on their way to Google.

066



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 19 of 52

AdWords does not accept online payment processors like PayPal at this time. We gladly accept several
credit and debit cards and, where available, direct debit and bank transfers. For more details, see What are

my payment options?

If you have prepaid for your AdWords advertising, you can request a refund for the full remaining
balance of your account. You will find the refund request form via the ‘request refund’ link on the 'Make
Payments' section of your AdWords account.

it can take up to a week after you request a refund to account for any outstanding advertising activity not yet
displayed in your reports. After all outstanding advertising charges post to your account, we'll initiate the
transfer of funds to your bank account (sorry, no cash or check refunds) and send you a confirmation email.
it can then take an additional couple of weeks for you to receive the funds, due to potential delays in your
country’s banking network.

After your refund is processed, you may make additional payments to your AdWords account. Your ads
will begin running again as soon as we receive a new payment. After we issue a refund, all payments we
receive (including payments initiated before a refund request) are considered attempts to reactivate an
account.

Don't worry. You are not committed to a payment when you generate a reference number. If you lose the
number, simply generate another one. If you decide that you'd like to pay less or more than the amount you
entered on your transfer information receipt, you may also do so by generating another reference number.

1.L0g into your AdWords account.

2. Select the My Account tab.

3. Click Billing Preferences.

4.Under Payment Details, dlick edit.

5. Use the pull-down menu to select your credit card type. (If you are switching to a new
card select the name of the new card.) Enter the new card information. Click Save Changes.

aawNe

K you have prepaid for your AdWords advertising, you can request a refund for the full remaining balance of
your account. The time it takes for you to receive a refund varies based on local bank networks. Please
allow 3-4 weeks for the entire refund process. If, after 4 weeks, your refund payment does not appear in
your bank account, please contact us.

Yes. Contact us within 3-5 days of requesting a refund for your prepaid AdWords account. If we haven't
already initiated the transfer of funds to your bank account, we may be able to place a stop on the refund.
Remember, refunds are only applied to prepaid AdWords accounts.

AdWords billing & payments : Understanding AdWords billing
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With the AdWords post-pay option, you pay only for clicks or impressions you've actually received, so
you are not billed in advance.

We create an invoice for your advertising charges and bill your account every 30 days, or after a certain
amount of advertising charges (as determined by history in the program) accrues. If you run a cost-per-click
{CPC) campaign, you accrue charges with every click; for a cost-per-impression (CPM) campaign, you
accrue charges each time your ad is shown.

The initial credit imit of $50 is incrementally raised each time an account hits its credit limit before 30 days
have ended. The credit limit is first raised to 1J5%$200, then to US$350, and then to US$500. The amount
invoiced and/for billed may be slightly in excess of the credit limit if an account accrues clicks very quickly.

For advertisers who meet our criteria, we will consider increasing credit limits beyond US$500. Although
credit limits cannot be increased in all cases, we are happy to review all such requests. Please note that if
you are approved for a credit limit increase beyond US$500, your card will be billed every 30 days or after
your new limit is reached.

Choosing a maximum cost-per-click

The pre-filed amount highlighted in blue is our recommended maximum CPC. Matching this amount
ensures maximum ad exposure and clicks for all of your keywords. Once you have decided on a maximum
CPC, click Calculate Estimates.

Assess your cost, click, and position estimates

The traffic estimator retumns estimates for how much you might pay per day for the keywords you have
chosen. In this example, the average cost per day is US$16.14 with an average CPC of US$1.62. You'll also

see the average position of your ad. Here, the average position is 1.5.
SR currency and maximum cokbpsr.
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You may decide that the Traffic Estimator predicted too many/few clicks at too high/low a CPC. If so, you
can enter a new maximum CPC in the maximum CPC field and click Recalculate Estimates.

You will now see a new list of estimates. In this example, lowering the maximum CPC to US$1.50 from
US$2.41 resuited in an average CPC that was, on average, US$0.86 lower. However, the average position
dropped from 1.5 to 2.3 and the average clicks per day dropped as well.

If cost is more important to you, you may choose to go with this recalculated option. If position and
exposure are more important, you may try option 1.

Choose currency and max

imum cost-per-click

o1 o ST

You can update your billing information from the My Account tab. Your account won't be activated and your
ads won't run until you submit your billing information for the first time. (If you are prepaying for your
AdWords advertising, your ads will not run until we receive your first payment.) To submit your billing
information:

.Log in to your AdWords account.

.Click Billing Preferences under the My Account tab.
.Complete the account setup process.

.Click Save and Activate.

Note: Once your account is activated, any new ads and campaigns you create will begin running
immediately on Google. You will not be asked to submit your billing information every time you create a
new ad or campaign.

To update billing information on an account which is already running:

.Log in to your AdWords account.

.Click the My Account tab.

.Click Billing Preferences.

.Click edit in the 'Payment Detalls’ section.
-Enter your updated billing information.
.Click Save Changes when you are finished.

In a word, no. We don't reveal individual data for any of our users.

However, we do have tools to help you calculate your own bid most effectively.
The AdWords Traffic Estimator will
show you the estimated average ranking of your ad, based on your bid.

Furthermore, the AdWords Discounter automatically adjusts your maximum cost-
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per-click (CPC) so you pay only one

cent more than the minimum amount
required to keep your ad's position.
For more about ranking, see How

are ads ranked?.

m Egg moﬂlhnﬁnda.u’ﬁ:ﬂd\mz—-

Google AdWords does not curently mail or email invoices to most advertisers. However, you can
print both an invoice and a receipt for charges to your AdWords account. To print a receipt, please
follow the steps below:

1. 1.Log in to your account.

2 2. Click the 'My Account' tab to load your billing summary. (If you would like to view the
billing summary for a specific date range, please select the appropriate months and years from the drop-
down menu at the top of the page once your billing summary has loaded.)

3. 3 Click 'Payment received' for any line item reflecting a charge to your account. (You can
also download your entire billing summary by clicking 'Download as .csv file" immediately above your billing
summary information.)

4, 4. Click 'Printable receipt' above the 'Payment Received' box. This will open your receipt in a new
window.

5. s. From your browser menu, select 'File' then 'Print.’

6. & From the printer prompt click 'Print.’

To print an invoice, please follow the steps below:

1. 1. Log in to your account.

2. 2 Click the My Account' tab to load your billing summary. (If you would like to view the
billing summary for a specific date range, please select the appropriate months and years from the drop-
down menu at the top of the page once your billing summary has loaded.)

3. 3. Click the invoice number for any line item reflecting a charge to your account.

4. 4. Click 'Printable invoice’ above the 'Invoice Details’ box. This will open om your browser
menu, select File' then 'Print.’

5. 5. From the printer prompt, click ‘Print.’

After you pause or delete all of your campaigns, you don't accrue any additional charges to your Google
AdWords account. However, because the AdWords program bills on a 30-day billing cycle, you may
receive a charge up to 30 days after you have paused or deleted your campaigns. You will be charged for
any activity that occured before you pause or delete a campaign.

You can verify the accuracy of a charge by adjusting the date range on the campaign summary page of your
account to include the dates between your previous invoice and your latest invoice. You'll then see the
statistics of clicks and impressions accrued between the selected dates.
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If you have chosen post-pay as your form of payment, you will typically have pending charges. Your pending
charges are detemmined by the amount of activity your ads have received since the last time you were billed.
To view pending charges for your campaign:

- Log in to your AdWords account.

. Click the My Account tab at the top of the page.

. On the Billing Summary page that appears, check your outstanding balance (this reflects
the cost of activity since you were last billed).

Note: The outstanding balance in your account provides an estimate for upcoming charges for your
campaigns. Please note that this amount does not necessarily reflect a delinquent amount, or a final
balance. It is likely that the outstanding balance in your account is more than what you are actually
charged for that time period; we will deduct overdelivery credits prior to billing your account. All credits
and past charges posted to your credit card are also available under the My Account tab.

To improve the overall AdWords billing experience, we’re upgrading most
AdWords accounts to a new billing system over the next few months. The
updated Billing Summary page will continue to reflect detailed information
regarding account charges and activity, and will include the foliowing changes:

-Your outstanding balance will now reflect any advertising charges since you
were last bilted to help you estimate upcoming charges for your campaigns.
However, this amount does not necessarily reflect a delinquent amount or a

ds google.

/supporvbinfindex py?ull 1 (58 of 116}8/212005 8:35:12 AM
f nal balance due.

-Your ad delivery period will reflect more specific date ranges. Advertising costs will be itemized only for the

particular month you are viewing to help make reconciling your charges easier. We recommend that you use
the Advertising Costs page for each month (which lists your charge details per campaign per month) when
reconciling your billing summary.

We hope that these changes help make your review and reconciliation of your AdWords spending simpler.

Reaching my audience : Reaching certain regions and language speakers

New campaigns (for new AdWords advertisers):

. From the AdWords homepage, click Click to begin under Sign Up Now. You'll arrive at
the campaign wizard.
. After naming your Ad Group, select your target language(s) from the scroll-down box.

Now select the radio button beside one of the three location options (Countries, Regions
and cmes or Customized)

. Click Continue.
D.. Now select your target location(s):

- If you chose the Countries option: Select one or more countries from the scroll-down box
on the left, then dlick 'add.’ Your selection(s) will appear on the right side of your screen.

. If you chose the Regions and cities option: Select your country from the drop-down box,
then proceed to add cities or regions below.

. If you chose the Customized option: Select your targeting method (either physical
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address or latitude and longitude) using the radio buttons. Enter your location information in the appropriate
fields. Designate the radius within which you'd like your ads to be shown.

On this page you also may choose the advanced multi-

point option, which allows you to enter coordinates to
outline the precise shape and size of your target area.

- Click Continue.
. Follow the wizard instructions to finish crealing your campaign.

New campaigns (for existing AdWords advertisers):

- LOg iNe v smies oo

. . After naming your new campaign and Ad Group, select your target language(s) from the
scroll-down box.

. Now select the radio button beside one of the three location options (Countries, Regions
and cities, or Customized)
. . Click Continue.
o. Now select your target location(s):

. If you chose the Countries option: Select one or more countries from the scroll-down box
on the left, then click 'add.’ Your selection(s) will appear on the right side of your screen.

. If you chose the Regions and cities option: Select your country from the drop-down box,

then proceed to add cities or regions below.

- If you chose the Customized option: Select your targeting method (either physical
address or latitude and longitude) using the radio buttons. Enter your location information in the appropriate
fields. Designate the radius within which you'd like your ads to be shown.

On this page you also may choose the advanced multi-
point option, which allows you to enter coordinates to
outline the precise shape and size of your target area.

. Click Continue.
. Foliow the wizard instructions to finish creating your campaign.

Existing campaigns:

. L.0G N yom ot wimes.
. Select the checkbox(es) next to the campaign(s) you wish to edit.
- Click Edit Settings above the Ad Groups table.
On the Edit Campaign Settings page, find the Languages field. Select your ad's target
language(s) from the

hitps:/adwords.googe.com/! fin/index.py?fulldump=1 (59 of 116)8/2/2005 8:35:12 AM
scroll-down boxes.
- Find the Locations field. Click Edit to change your campaign’s target locations. Click
Contmue to return to the Edit Settings page.
. . When you're done, click Save All Changes.

You can find the coordinates for your business location at a variety of mapping sites such as Maporama or
Multimap.

To find your coordinates on Maporama:
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. Visit the Maporama website.
. Under the Maps header on the left side of your screen, select your target country from the
drop down box, then enter your address information in the appropriate fields.
. Click Go.
A graphical depiction of your address will appear in a map. Locate the Information
header below this map. Your coordinates will appear beside the phrase Lat-Long.

To find your coordinates on Multimap:

. Visit the Multimap website.
. Click the Maps tab at the top of your screen.
. Below the Quicksearch header on the left side of your screen, select your target country
from the drop down box, then enter your address information in the appropriate fields.
. Click Find.
A graphical depiction of your address will appear in a map. Locate the Map Information
header below this map. Your coordinates will appear in the second line of text.

Regardless of the mapping site you choose, your coordinates will appear in the same general format. For
example, the latitude and longitude for 1600 Amphitheatre Parkway, Mountain View, CA 94043 USA is:

37* 25 38", -122* 5' 57"

When you target your ads to geographic locations, you have the following three options:

. .Countries: Your ads will appear to customers located in or searching for results in the country or
countries you select. This option is best suited for global businesses and merchants who serve specific
countries.

. Regionslcities: Your ads will only appear to customers searching for resuits in (or located
m) the regional areas/cities you choose. This option is best suited for businesses specializing in certain cities
and states and stores with target customers located throughout a city or cities. (Please note this regional
option is only available in some countries.)

. Customized: Your ads will only appear to customers searching for results in (or located -
ln) a specified distance from your business. This option is best suited for businesses serving a specific area.

Regional and customized targeting is designed to benefit advertisers who want to reach customers in
specific geographic areas. For these advertisers, it's a powerful way to reach more qualified
prospects.

If this seems appropriate for your business, you may want to create a regionally-targeted or customized
campaign in addition to a country-targeted campaign.

Sometimes we're unable to determine the intended region or the physical
location of a searcher. This may occur when:

. The searcher hasn't entered location-specific terms in his or her query.

. The searcher has ambiguous location terms.

- The searcher's internet service provider (ISP) employs a proxy server, preventing us from
|dent|fy|ng his or her

hitps:/fadwords. google. /sopp in/index py7folldump=1 (60 of § 16)8/2/2005 8:35:12 AM
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IP address.

Because we can't determine the searcher’s location in these cases, we'll show nationally-targeted ads
instead of regionally-targeted ads.

Helpful Tip: Need help with finding your ad? Our Ads Diagnostic Toof can let you know whether your ad is
appearing on the first page of search results, and identify why a particular ad or group of ads may not be
showing. You can access the tool at any time via the Tools link on the Campaign Management tab.

The AdWords system first analyzes a searcher's query to establish what region that person is searching for.
It may also take note of the person’s Internet Protocol (IP) address to see where he or she is searching from.
The system will then examine these factors and others to determine the best targeting for your ads.

If the AdWords system can't identify appropriate {argeting for your ads, it will show national/global ads
instead.

Your regionally-targeted and customized ads can appear alongside search results for Google users in
your targeted location(s). We identify a user's geographic location by using the computer’s IP {Intemet
Protocol) address.

In the United States, your regionally-targeted and customized ads can also appear alongside Google
search resuits for location-specific search queries {such as 'New York pizza'), regardless of the searcher’s
geographic location.

if your campaign is opted in to Google’s search and content networks, your customized or regionally-
targeted ads can also show on some sites and products in the Google Network. However, they currently
won't appear on AOL. Only country-targeted ads will appear on the entire Google Network.

Remember, you can still reach prospects on all partner sites (including AOL), by creating additional,
country-targeted campaigns. Just remember to include location-specific keywords and ad text in your
campaign.

Yes. Simply create new campaigns, each targeted to different geographic locations, to maximize your
advertising reach. For example, your account might contain a campaign showing ads to one or more
countries, a campaign showing ads to regions/cities, and a campaign only showing ads within a set distance
from your business location. You can then modify the ad text in each campaign to make your ads more
relevant to your target prospects in various geographies.

When you're tailoring your ad text, remember the following:

. You won't need to include place or region names in the ad text of your regionally-targeted
or customized campaigns because the AdWaords system will automatically focus your ads to the region
you've specified. Users searching on broad keywords, such as 'refrigerator maintenance,’ will still see your
ads.

. You should, however, include place or region names in the ad text of your country-
targeted campaigns if you want to attract users outside your area. In this instance, you would include more
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specific keyword phrases and place names in your ad text, such as '"New York refrigerator maintenance.’

AdWords will identify your chosen region or city in your regionally-targeted ads to
distinguish them from country-targeted ads. For example, the following ad is
regionally-targeted to the New York, NY area:

WidgetWorld
Wide variety of widgets.
Check out our special deals.

widgets.google.com
New York, NY

if you use customized targeting, the location will not show in the last fine of your
ad.

No. CPC estimates will be calculated the same way for nationally-targeted and regionally-targeted
campaigns.

If you select the customized targeting option for your campaién(s), your ads will only appear to customers
searching for results within (or located within) a specified distance from your business. The region where
your ads appear will be typically be a circle around your business location.

. . First you set the center of this region with your business address or latitude and.longitude
coordinates.

. You then set the advertising distance (the radius of the circle) in miles or kilometers.

. The AdWords system will translate searchers' locations into latitude and longitude

coordmates and determine whether they fall into your target region.

You can target your ads to multiple languages and over 250 countries. You can also target regions/cities
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within a limited number of countries.

You may change these language, country, and regional seftings at any time.

No. Your campaign may only target regional areas in the same country. However, you may create a
separate campaign for each unique country containing areas you'd like to target.

If you select the customized targeting option for your campaign, your advertising region will be a circle
around your business location. However, you can modify the shape of your advertising region by cheosing at
least three latitude and longitude points on the map. The AdWords system will connect these points to
define a targeting area of virtually any size and shape. Your ads will appear to people searching within this

Yes. Because campaigns with regional and customized targeting focus on a narrower audience, keyword
traffic estimates may be lower than those for nationally-targeted campaigns. The actual difference in traffic
estimates will be determined by the regions you target.

We've found that we can determine the searcher’s desired location correctly in the majority of tests we've
run. In addition, because your ads clearly display their target regions at the bottom of the ad text, chances
are minimal that a searcher not interested in that area would click on your ad if it were incorrectly targeted.
Therefore, we won't issue credits for incorrectly targeted ads.

Reaching my audience : Making my keywords work for me : Selecting the right keywords

After setting your advertising goals, the next step is to build out your keywords. This can sometimes be
daunting, especially if you're just beginning, but here are 4 steps to get you started on the path to creating
an effective keyword list:
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1. Expand your keyword list to include as many relevant words as possible.
2. Target the keyword list by using keyword matching options.

3. Scrub or refine the keyword list.

4. Group the keywords in thematic clusters to be paired with different ads.

el A

Step 1: Expand

First, review your site content to identify which keywords (word combinations and phrases) describe the
main categories of your business. Write down every relevant keyword under each category you find. Expand
the list by including all of your brand and product names as well as plurals and synonyms for each word or
phrase on your initial list. Also, remember to think like your customers. How might your customers ask for
your product or service? (Don't worry about capitalization — our system is not case-sensitive.)

If you're still looking for more keywords after your own brainstorming, try out our keyword tool.

Step 2: Target

Now if's time to target your keywords using Google's keyword matching options. These enable you to pin
point ad deliver so your ads reach people precisely when they are searching for what you have to offer. You
can choose to designate each of your keywords as a broad, phrase, exact or negative match. Each type of
match provides a varying degree of exposure.

For example, a broad-matched keyword will allow your ad to appear on your keyword as well as variations
and synonyms of that keyword that the AdWords system identifies as relevant. However, a negative-
matched keyword will never trigger your ad. Decide which of your keywords you would like to place where
along this spectrum.

Step 3: Scrub

After creating, expanding, and targeting your list of keywords, it's time to refine it. To do this, review

your list and make sure you're satisfied with what you've come up with. Eliminate any keywords that

may be irrelevant.

Step 4: Group

You've already created different 'buckets’ for your words based on your product lines. Now it’s time to do
even more refined and granular grouping into thematic categories, which are called Ad Groups. Organizing
and grouping keywords is crucial because you have to write ad copy targeted to each group. :

The best place to start your keyword search is on your own website. Reading through your web pages will
help you identify the key themes and terminology associated with your business or product lines.

Then, take a minute to try to think like your customers (your target audience). What are the terms your
customers would use to describe your product or service? Often these colloquialisms are overlooked,
yet they are valuable alternatives for your keyword list.

Finally, the keyword tool can provide you with temms. It will give you common search queries including or
pertaining to your keywords. You can use the relevant results to supplement your list. And you can add any
imelevant terms to your keyword list as negative matches.

Our system doesn't recognize URLs as keywords; therefore, Google AdWords ads won't display for
keywords in the form of a URL (www.domain.com, for example). If a user searches for your domain URL,
your website will appear in the Google search resuits, but no ads will appear. We recommend that you
select keywords that are relevant to your products and services and refrain from using URLSs as keywords.
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The Keyword Tool is not guaranteed to produce keywords that will improve your campaign’s
performance. It is a useful tool for helping you discover keywords that may be related to your account.

However, some of the terms may not be relevant for you. In this case, you may consider adding them as
negative matches.

All keywords you add to your keyword lists are subject to review according to both our editorial discretion
and policies, which are applied outside any data the Keyword Tool may return on a given search. The
altematives you may receive for your submitted keywords are not edited to ensure that we provide the most
accurate representation of Google search behaviors, and of what keywords may trigger your ads. Please
also note that the Keyword Tool does not take the individual performance or content of your existing ad(s)
into account when returning keyword alternatives.

You may notice occasional changes in your Keyword Tool results for a given keyword. As part of our
ongoing effort to improve the Google AdWords program for advertisers and users, we may periodically
update our keyword index to give you more relevant and current keywords.

Learn more about building an effective keyword list.

Reaching my audience : Making my keywords work for me : Keyword matching options

Keyword matching options are four different methods of targeting your AdWords
ads to users. With some options, you'll enjoy more ad impressions; with others,
you'll get fewer impressions (but potentially more clicks). By applying more
focused matching options to your keywords, you.can reach the most appropriate
prospects, reduce your cost-per-click (CPC), and increase your ROI.

Your options are:

Broad Match - This is the default option. If you include general keyword or
keyword phrases-such as tennis shoes-in your keyword list, your ads will
appear when a user’s query contains tennis and shoes, in any order,

hetps:/ladwords. google. com/supportbin/index py?fi 1 (64 of 116)8/2/2005 8:35:12 AM
and possibly along with other terms. Your ads will also automatically show for expanded matches, including
plurals and relevant variations. Because broad matches are sometimes less targeted than exact or phrase
matches, you should create keyword phrases containing at least two descriptive words each. You can also
try the keyword tool and the other three matching options to further refine your targeting. Finally, keep in
mind that other advertisers may have bid for the same broad-matched keyword combinations that trigger
your ads,

increasing your actual CPC amounts. Using exact, phrase, or negative matches can help you keep your
costs low.

Phrase Match - If you enter your keyword in quotation marks, as in "tennis shoes,” your ad will appear when
a user searches on the phrase tennis shoes, in this order, and possibly with other terms in the query. For
example, your ad will appear for the query red tennis shoes but not for shoes for tennis. Phrase matching is
more targeted than broad matching, but slightly more flexible than exact matching. To ensure your ads are
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as targeted as they can be, you may want to include at least two descriptive words in your keyword phrases.

Exact Match - If you surround your keywords in brackets-such as [tennis shoes}-your ads will appear
when users search for the specific phrase tennis shoes, in this order, and without any other terms in the
query. For example, your ad won't show for the query red tennis shoes. Exact matching is the most
targeted option. Although you won't receive as many impressions with exact matching, you'll likely enjoy
the most clicks, because users searching for terms in this manner typically want precisely what your
business has to offer.

Negative Keyword - If your keyword is tennis shoes and you add the negative keyword +ed, your ad will
not appear when a user searches on red tennis shoes. You can apply this option for a keyword at both the
Ad Group and campaign level.

To leam more about the benefits of keyword matching options, view our brief onfine demo.

You can also easily change the match options for multiple keywords throughout your account with our find
and edit keyword tool located in the Tools section of the Campaign Management tab.

With expanded matching, the Google AdWords system automatically runs your ads on highly relevant
keywords, including synonyms, related phrases, and plurals, even if they aren't in your keyword lists. For
example, if you're currently running ads on the keyword web hosting, expanded matching may identify the
keyword website hosting for you. The expanded matches will change over time as we leam more about
which new keywords best suit the true meaning of your ads.

Expanded matching only applies to your broad-matched keywords. This feature doesn't affect keywords
you've specified as phrase matches (keywords surrounded by double quotation marks) or exact matches
(keywords surrounded by [} brackets). Also, expanded-match terms aren’t included in our calculations for
your minimum CTR requirement; therefore, they don't affect your ad's rank.

Google AdWords provides an easy way for you to monitor the status of your
keywords and their associated ads.

You can proactively monitor your keyword performance by reviewing the
status column on your keyword summary page. Each of your keywords
(except any negative keywords) will be identified by one of the following
states:

. Normal: Targeted keywords are above the minimum 0.5% CTR on Google search pages,
and their associated ads show regularly. There's currently little to no risk to your advertising exposure.
However, every Ad Group can use occasional optimization, so you may want to consider periodic re-
evaluation of your ad text and keywords.

- in trial: Keywords are slightly below the minimum threshold and are in evaluation until
we're statistically confident their CTR is below or above 0.5%. These keywords may become normal or
disabled. They may also be slowed, giving you an opportunity to refine them as needed.

There are a limited number of in trial keywords per account, so when this
limit is reached, additional keywords will be moved to on hold status with
priority given to those keywords with higher predicted CTRs. Accounts
that have proven to perform very well will be rewarded with a greater
number of in trial keywords. The limitation placed on the number of
keywords that may be placed in trial helps ensure that advertisers

Ty

079



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 32 of 52

continue to see the most targeted, relevant ads via the AdWords program.

hitps//adwords. google.comny tp=1 (65 of 116)8/2/2005 8:35:12 AM

. On hold Your account’s in trial keyword limit has been reached, and these additional
keywords are slightly below the minimum threshold. As more space becomes available, these keywords will
move into in trial status, with priority given to those keywords with higher predicted CTRs. There is no limit
placed on the number of on hold keywords you may have within your account. You may want to refine these
keywords.

. Disabled: Disabled keywords no longer trigger your ads. If you still feel strongly about
usnng these keywords, you have a few options.

If ‘normal’ appears beside your keywords, your keywords are performing adequately, and you don't need to
take any action unless you'd like to.

Broad and phrase keyword matching options allow your ads to appear for queries that don't exactly match
your keywords. This provides you with additional ad coverage without having to generate an exhaustive
keyword list. However, what if not all variations work well for you or what if a keyword isn't as targeted as it
could be to begin with? There is a greater chance that you'll accrue less-targeted dlicks and inflate your
costs. We take a couple steps to help prevent this.

First, your broad- and phrase- matched keyword variations must maintain a high relevance factor
(automatically determined by analysis of Google search queries, your ad text, keywords, and CTR).
The evaluation of these matches is, in most cases, stricter than the CTR performance requirement for
the exact keyword form.

Additionally, the keyword variations and expanded broad matches are monitored closely and can be
disabled if they don't achieve a high enough relevance factor. {Your original keyword can continue to be
active even if some of its vaniations are disabled.) This way, your keywords aren't penalized for
underperforming variations or expansions.

Expanded matching offers the following benefits:

. Because your ads are associated with additional keywords, they'lt appear more often to
your potential customers. And because these new keywords are so relevant, your ads show to people who
will likely be interested in clicking on your ads.

Expanded matching is a "smari” feature. it automatically retains only the highest-
performmg new keywords. After a few cycles, it learns.what additional keywords to create in the future
based on the most successful combinations.

. The AdWords system constantly monitors all user queries and bases its optimization on
the analysis of these gueries. It increases your relevance to prospects by automatically tuning your lists over
time-without requiring any additional effort from you.

You can view sample matches by entering a keyword into the keyword tool. You can add the expanded
matches to your account manually. However we recommend you let the system automatically tune your
matches over time as it continually analyzes your performance.
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Yes. If you don't want your ads appearing on particular expanded-match keywords, you can add that
particular keyword as a negative match in your keyword list.

Also, expanded matching only applies to broad-matched keywords. The system won't create expanded
matches for any of your phrase- or exact-matched keywords. Therefore, if you don't want expanded
matching on any of your keywords, you can simply turn them into phrase or exact matches. (Keep in mind
that narrowing your advertising focus with phrase or exact matching may decrease the number of ad
impressions you receive. However, because your ads will be more relevant to target users, your clickthrough
rate may also improve.)

Reaching my audience : Places where my ads will appear : The Google
Network

The Google Network is made up of sites and products who partner with Google to publish targeted
AdWords ads via their site or product. Google can target your ads te search results and relevant web
content on a wide variety of sites and products to help you reach a vast and highly-targeted audience. We
are constantly expanding the number of sites and products in our network through our premium services
and our online Google AdSense program. All web

sites and producls are reviewed and monitored according to the same rigorous standards, so as the
network grows, your AdWords ads will continue to appear only on high-quality sites and products.

Besides appearing on search results on Google.com, AdWoerds advertisers can choose to have their
keyword-targeted campaigns appear on our search network, our content network, or both. New keyword-
targeted campaigns are automatically opted in to distribution on the Google Network, so if you want your
ads to appear on search and content sites and products, then you don't need to do a thing. To learn how
to view or edit your distribution preferences, please dlick here.

As an AdWords advertiser, you also can elect to create site-targeted campaigns, in which you choose the
exact sites where your ad will appear rather than choosing keywords to trigger your ads. Site-targeted
campaigns appear only on content sites in the Google Network, and only websites and only on the specific
sites you select. They don't appear on other sites in the Google Network or on Google.com. To learn more
about site targeting, please see click here

Other Google Network facts you might like to know:

. No additional fee to participate in this program.

. Some sites and products show as few as the top 3 ads per page, so the higher your
average ad position, the more exposure you'l get.

. All ads are reviewed before appearing across the Google Network, so you may see your

ad appear on Google first. Please note that if you edit a previously reviewed ad, your ad will show on the
Google Network once it is reviewed again.

Google offers several ways for you to Join the Google Network and dispiay AdWords ads on your sita.

Googte AdSense for content-A fast and easy way to unleash the true revenue potential of your web content pages. Web publishers of any size can
apply online. Once approved, you can publish AdWords ads on your site within mi If your site ives more than 20 miflion page views a
month, you may be eligible for premium service.

Google AdSense for search -Websites that conduct a mmimum of 5 million searches per month can display AdWords ads on their search results
pages.
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You can select individual sites where your ads will appear by running a site-targeted AdWords campaign.

You're given the choice of site targeting or keyword targeting each time you create a new campaign. Each
new campaign can use site targeting or keyword targeting, but not both. Site-targeted ads appear only on
content sites in the Google Network, and only on the individual sites you select. The don't appear on search
network sites or on Google.com. Keyword-targeted campaigns appear across the entire Google Network,
but are not eligible for site targeting.

For more about site-targeted campaigns, please see our FAQ.

To make your keyword-targeted advertising as effective as possible for you and your users, we require that
your account and individual keywords maintain a minimum clickthrough rate (or CTR). However, while
tabulating and evaluating your CTR, we only consider activity on the Google search pages. Your ads
distributed to the Google Network are not used in evaluating your performance.

Reaching my audience : Places where my ads will appear : Showing my ads on search network

Ad appearance will vary by Google Netwosk partner. However, the ads are typically labeled as sx d links

and coul indlude 2 - 4 lines of text. Ads may appear either down the side of or above the search resuits. Here Is
an example of what your ad could look like on Google:

heps://adwords.google: /support/binfindex. py?fulldump=1 (67 of 1 16)8/2/2005 8:35:12 AM

e 2 YOUS ad on Google and
Google & ’”“E‘"‘"T“Tﬁ our pariner sltes.

g

Your ads wil always appear on the Google search site, but you can choose whether your Google AdWords campaigns also appear on either of our
search or content networks, or both. To view or edit your distribution preferences, please click here.

We recommend advertisers distribute their ads auosshe entire Google Nt ri, as it imizes the ber of highly-qualified leads that you can
receive. Google technology ensures that your ads appear only on high-quality pages and prodi that are directly ref t to your service. As
always with Google AdWords, you only pay for clicks you receive, so you have nothing to lose but potentiat customers.

Reaching my audience : Places where my ads will appear : Showing my ads on content network

Contextual advestising. sometimes referred to as Content Targeting, is an innovative feature of Google AdWords that enables you to gain more
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customers easier than ever before. Bullding on owr successhl keyword targeting technalogy, we place highly-targeted AdWords ads on content
pages within our extensive netwark of high-quality partner sites and products. This service, known as conextual advertising, improves the
experience of web users by disptaying useful ads, and it provides several benefits to Google advertisers:

1. 1. RO! Po«formance Keyword-targeted oontexmal ads bnng unique, pre-qualified leads for a cost-per-click that you set yourself.
2. 2. reach: the of p s that see your ads, and drive more incremental clicks to your
webssite than you could reach with search advertising alone.

3. 3 Save Time and Money: Contextuat targeting Is one of the fastest and easiest ways to get your ads to more relevant places
on the Web. And you only pay for clicks that you receive.

By electing to show your ads on the Google content network, you can expand your reach to prospects
visiting a variety of high quality websites that are relevant to your business. However, there may be times
where—for any reason—you feel that certain websites aren’t appropriate for your ads. If this is the case, you
can apply the AdWords site exclusion feature to prevent your ads from appearing on these sites. With the
site exclusion feature, you can enjoy the benefits of advertising on the content network while still precisely
controlling your targeting.

Please note the following about the site exclusion feature:

. This feature is available only lo advertisers who are opted in to the content network.

- The content network is continually evolving and growing. As a result, we can't provide a
hst of all sites which are eligible to show your ads. By using this feature you can simply filter unwanted sites
in case they are or become part of the content network.

. You may edit your list of excluded sites at any time, and as often as you like.

If you'd like to use the site exclusion feature, follow these simple instructions.

iy st e content etvicrk o Epssent my g

To prevent your ads from appearing on specific websites, you may apply the
AdWords site exclusion feature. First you may wish to confirm that you're opted
into the content network. You can then follow these instrnuctions:

1. Log in to your AdWords account.

2 Click Tootls at the top of your Campaign Summary page.

3. Click Site Exclusion under the Modify Your Campaigns header.

4. Select your campaign from the drop down box and click Go.

D s.In the field under "Add sites to be excluded,' list the websites you want to exclude from showing your
ads.

EPENES

. . Add only one website per line. Do not separate websites with commas or other
punctuation.

- Enter websites at the domain (www.example.com, example.com), subdomain
(toplc example.com), or path (www.example.com/stuff) level only.
. . Do not enter individual pages (www.example.com/main.html).
hitps://adwords.google. com/supp findex py?fullch 1(68 of 116)8/2/2005 8:35:12 AM

6. When you're done, chck Save List. You'll see a confirmation page informing you how many websites
you've chosen to exclude.

Please note that you may exclude sites only at the campaign level. That is, if your account contains
multiple campaigns, you must create a list of excluded sites for each campaign if you want to filter
unwanted websites completely.

With the AdWords site exclusion feature, you have several options for filtering websites. You may enter a
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domain, subdomain, or path name. You may not enter individual pages.

The format of each entry on your site exclusion list determines how the AdWords system will filter sites.

Acceptable formats:

. Domain: www.example.com

. Domain: example.com
- Subdomain: unwanted.example.com
. One path name: www_example.com/widgets

. One path name: examplie.com/widgets

Unacceptable formats:

. Multiple path names: www.example.com/widgets/redwidgets

.Individual page: www.example.com/index.html. Site Exclusion Scenarios: In general, entering
domains will prevent your ads from appearing on any page on or within that domain. However,

entering subdomains or paths will only prevent your ads from appearing on any page on or within that
subdomain or
path.

For instance:

If you enter example.com. ..
Your ads will not appear on example.com, www.example.com, www1.example.com,

www.example.comiwidgets, www.example.com/widgets/page.html, or unwanted.example.com.

If you enter www.example.com. ..

. Your ads will not appear on www.example.com, www.example.com/widgets, etc.
. Your ads may appear on www1.example.com or unwanted.example.com.

If you enter www.example.com/widgets .. .

. . Your ads will not appear on www.example.com/widgets or
www_example.com/widgets/page.html.
. Your ads may appear on www.example.com.

Text-based ads on our content network are the same ads that appear on the
search results pages of Google and our global search pariners. In addition,
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AdWords advertisers now can place image ads on content network sites if they
choose. Aithough ad placement will vary, AdWords ads are typically identified as
sponsored links. Ranking for all contextual ads is determined just as on search
results pages—based on various factors like the maximum cost-per-click you have
selected, the dickthrough rate that your ad has established on Google.com, and
the quality of your ad text and keywords.

Google AdWords Ads on Content Network

https//: google. ¥ ivindex py’ 1 (69 of 116)8/2/2005 8:35:12 AM
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Creating effective ads that bring you sales on search and content pages is easy. There afe a few steps you can take to ensure that your ads are
bringing you the highest possible retum on your advertising investment on Google search and content pages.

1. 1 Oplimize your campaigns as you would for search advertising. Search ads are typically good predictors of contextual
advertising performance. This means that the better your ads perfonm on search pages, the more successful they are likely to be on content sites and
products. For more information on improving your AdWords campalgn, please visit our optimization tips page.

2. P 1t Googl ion tracking. C H king allows you to see the number of sales that you are receiving
from your advertising campaign, for both our search and content network sites and products. Reviewing your total number of conversions and the
value of these conversions can help you delermine if you should increase your budget or further opimize yous ad groups to receive more targeted
visitors. Leam more about

Google conversion tracking.

2 3 Review your ad ranking. Keep in mind thal most content sites and products only display two, three, or four contextual ads per
page. As a result, you must select 2 maximum cost-per-click that allows your ad to rank In these top positions if you are to take advantage of the
additional qualified clicks from content pages. Look at the average position of your ads on the Campalgn Management page and adjust this position
as necessary (by improving your clickthrough rate with refined ad text and keywords, or adjusting your maximum CPC}) o ensure that you are
receiving as many profitable leads as possible.

Contextual advertising provides you addifional targeted visitors at a cost you set. H b the perfo of your ads on content pages
does not affect their performance on search, a lower number of clicks or clickthrough rate an cor i adverlising will not adh y affect your
campaigns.
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Your keyword-targeted ad is ranked on the search results and content pages based on various
performance factors including: maximum cost-perclick {CPC), dlickthrough rate (CTR), and ad text. Having
relevant ad text, a high CPC and a strong CTR will result in a higher position for your ad.

Visit our Optimization Tips page to leam more about account optimization, including how to maximize
performance for your ads and improve your ad's position without having to raise your maximum CPC. You
can also leamn about how to optimize ad serving for your ads on this page.

When you choose a maximum CPC for your keywords, our Traffic Estimator gives you the estimated
average ad position per keyword. This estimate is based on your maximum CPC and the average CTR for
each of the keywords you've chosen.

Though you set just one maximum CPC for a given keyword, content network
clicks aren't priced the same as search clicks. Google's smart pricing feature
automatically adjusts the cost of a keyword-targeted content click. So if our data
shows that a click from a content page is less likely to tum into actionable
business results - such as online sales,

----- D8/ google.

P /s i y? 1 (70 of 116)8/2/2005 8:35:12 AM

registrations, phone calls, or newsletter signups - we reduce the price you pay for that click. With no extra
effort for you, Google technology helps ensure you get strong ROI from your AdWords advertising, wherever
your ads appear.

If you are a new or existing AdWords advertiser, your keyword-targeted ads automatically begin appearing
on relevant content sites and products. Utilizing our advanced search technology, Google scans the content
of a Web page and automatically selects ads to display that have keywords closely matching the subject of
the page. For example, if users look at a Web page about building hummingbird feeders, they may see
Google AdWords ads for hummingbird feeders or hummingbird food. Or, if a users view a page containing
brownie recipes, they may see ads about chocolate brownies or delicious dessert recipes. You don't have fo
waste time trying to find the right content venue to display your ads. Our advanced algorithm makes it easy
by displaying your ads automatically for the most relevant content.

086



Case 5:05-cv-03649-JW  Document 49  Filed 05/18/2006 Page 39 of 52

1. 1. A web user visits a webpage looking for items to purchase that are related to your product.
2. 2. Your ad is matched automatically to the relevant page each time it is viewed.
3. 3. With cost-per-click pricing, you pay only when a user clicks on your ad.

On Google’s content network, ads are not triggered by speaﬁc individual keywords as they are on search sites. Instead, an advertiser’s entire
keyword list is taken into ideration. Google's ach hnology scans the content of the web page and matches that content with ads that

feature the most appropriate keywords overall.

For example, if users ook al a Web page contalning brownle recipes. they may see your ad if you simply have brownie—related keywords such as
It b *or p

Since individual keywords don't trigger your ad, your Ad Group statistics will not show a key 4-by-keyword kdown. Instead, you'll see an overall
total of all clicks that ad has received on our content network.

On a bysy content page, an ad has to compete more fo get the attention of a reader than it would on a search page, so content CTR is typically lower
than search CTR. If's nothing to worry about, because content CTR does not affect the ranking of your 2d on search pages.

The lechnology that drives AdWords ¢« | advertising comes from Google’s award-winning search and page ranking technology. Based on a
sophisticated algorithm, we can comprehend a page's meaning and then figure out which keywords relate best to the content page. Then, we match
ads that are precisely targeted to the page based on the associated keywords. This means that in addifion to reaching customers who

specifically search on your keywords, you can now reach customers who view Web content directly refated to your AdWords ads. For ple, if
someone visits a web page on astronomy he/she would be served Google AdWords ads for telescopes. Contextual Advertising benefits Web users by
linking content with relevant products and services. This is great for Google advert: ke you, b you can now reach more prospective
customers on more places on the Web.

With Google, you can say goodbye to contracts and deadiines. Unlike a traditional online advertising buy,

Google's conlextual advertising requires no prepay t and no packages. Just enjoy pl 1t on web pages in

the Google Network that happen to have just the sight content, right then, to make a

Hitps:H/adwords.google. Pbin/indexpy?h 1(71 of 116)8/2/2005 8:35:12 AM
matchbeMeenyouradardaﬂn'erestedreader With Google AdWords, you your ign to the perk trics you want.

oy
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We recognize that you may have display concemns specific to your company or brand. For instance, you may
not wish your ad to be shown next to an article about your company earnings. To customize Google
contextual advertising for such special circumstances, we recommend you apply appropriate negative
keywords or site exclusion io your campaign. (For the example given, you might choose 'earnings’ as a
negative keyword, or you might choose to have your ads blocked from that entire website.) This will help
ensure your ad is not shown alongside content with the specific themes you wish to avoid. You can update
and change these negative settings at any time. To leam more, please see our how-to pages on negative
keywords and site exclusion.

You may also wish to consider a site-targeted campaign, which allows you to select the precise sites
where your ad will appear. For more on this AdWords feature, please visit our Site Targeting FAQ.

The perf of your advertising does not affect the ranking of your ads in any way. We do require that your account and individual

keywruds B a »ugh rate (CTR) in order to ensure your advertising is as effective as possible for you and for users. However,
b we only ider the perf( of your ad on Google search pages when evaluating your account and keywords, contextual advertising
does not impact your account performance in anry way. Clicks from contextual targeting mean additional qualified leads for you at no risk to the

perft of your paign.

Campaigns that produce great business results on search typically do well in the content network. Ad Groups with keyword lists that are focused
around a theme, product line, or brand tend to perform better than Ad Groups with Kists of unrelated keywords. And, just as in search advertising, ad
text with a specific call to action outperforms ad text that's simply descriptive, which may attract more browsers than buyers.

Google has a ber of safeguards to help that ads are not shown on inappropriate content. We use sophisticated technology to detect pages

with sensitive content, and ensure that no ads are served on them. In addition, we have tools in place to immediately remove ads if they do appear on
a page with questionable content. Publishers like Forbes.com and many other distinguished properties trust that our iters work.

Reaching my audience : Site-targeted campaigns

Site-targeted campaigns are a new enhancement to Google AdWords. Site
targeting lets advertisers choose individual sites in the Google content network
where they’d like their ads to appear. If you want to place your ad on a single
international website, you can. If you want to target dozens of sites about
basketball or orchids, you can do that too. Site targeting lets you hand-pick your
audience, big or small.

When you set up a site-targeted campaign, you first name the sites where you'd
like to advertise, or just give us a list of words that describe your site. The
AdWords matching system does the rest, analyzing your input and creating a list
of available Google Network sites for you to choose from.

Remember that a site must be part of the Google Network in order to be available
for your site-targeted campaign. Being part of the Google Network means the site
has agreed to run ads provided by Google, which in tum allows your AdWords ad
to compete for that space.
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As with all AdWords advertising, you'll compete for space with other
advertisers. If you choose very prominent and popular sites, you'll need a
higher price to win the ad position. The minimum cost-per-thousand (CPM) bid
for a site-targeted ad is US$2.00.

Who should have site targeting? Should 1?
Anyone who has an AdWords account can run site-targeted ads.

Site-targeted campaigns can be a good option for businesses who want to
promote an existing brand or a new product to a large audience. But they also
work for small advertisers who want to reach a very precise audience. As
always with AdWords, we suggest that you experiment and see what works
best for you.

Of course, if you're happy with your keyword-targeted ads, there's no need to
change. Site targeting is not replacing

ds_google. /s dex py?fi p=1(72 of 1 16)8/2/2005 8:35:12 AM
keyword targetlng. and everythlng you love about your AdWords keyword-targeted campaigns remains
the same. Site targeting is simply one more tool that AdWords advertisers can use to bring their message
to highly-targeted groups of web users.

How do | create site-targeted ad campaigns?

To create a new site-targeted campaign, please click here. For more general information about site
targeting, please see the complete FAQ.

You can create a site-targeted or a keyword-targeted campaign at any time. Each new campaign can use
site targeting or keyword targeting, but not both. Site-targeted ads appear only on the Google content
network, and only on the sites you select.

To create a new site-targeted campaign, follow these steps:

. . Log in to your AdWords account at http://adwords.google.com (if you're not already logged
in).

. On the Campaign Summary page, click the 'Create a new site-targeted campaign'’ link just
above the table of existing campaigns.

. Follow the sign-up wizard instructions to create your campaign.

In CPM advertising, advertisers set the maximum amount (max CPM) they're willing to pay for each 1000
impressions their ad receives. The price paid is the same whether users click on the ad or not. This is
different from cost-per-click (CPC) campaigns, where advertisers pay only when their ad receives a click.

Advertisers have told us that CPM pricing is a tool they'd like to have available for their AdWords
campaigns. Some advertisers want the flexibility to reach customers early in the advertising cycle, with
ads designed to increase awareness but not necessarily generate clicks or traffic. Others prefer the
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traditional industry metrics of CPM campaigns. As a resuilt, we're making CPM pricing available to those
who prefer it.

CPM pricing is currently available only with site-targeted ads. Advertisers select the sites where they'd like
their ad to appear, and set a max CPM that applies for all those sites. CPM ads are then ranked for display
according to their max CPM, competing with other CPM ads and with keyword-targeted cost-per-click
(CPC) ads. A CPM ad occupies the entire ad space, with either an image ad or an expanded text ad.

As always, the AdWords discounter automatically reduces any winning CPM bid so that the amount
charged is the minimum necessary 10 keep the ad's position on the page. As a result, the max CPM an
advertiser sets is rarely the amount actually paid.

Google ads with CPM pricing continue to have a very high ievel of relevancy. CPM advertisers use site
targeting to select the specific audience that will be interested in their message. CPM ads compete with
keyword-targeted cost-per-click ads, and high relevancy continues to boost the ranking of those CPC ads.
We also have set a high minimum CPM value to ensure that advertisers choose their ads and their
audiences with care.

For more about how CPM ads are ranked, please see How do CPM and'CPC ads compete with each other?

When you run a site-t d A 1, you set the maximum price you want to pay for every thousand
lmpmssorsmadge\smmme This is calied the max CPM. When you run a traditionat AdWards keywnrd-
targeted ign, you set the price you want to pay every time someone dlicks on your ad. This is the

maximum cost per click, or max CPC.

Becausa the two pricing systems are different, AdWords uses a system of effective CPM, or eCPM, o compare
and rank them. '

For keyword-targeted ads, the AdWords d X ki iders the ad’s cost per click (CPC),
cickthrough rate (CTRY), and other relevance factors, all taken across 1000 impressions. The resulting
figure is the ad's eCPM, or eflective cost per 1000 impressions.

For any available ad position, the eCPMs of keyword-targeted ads are compared {o each other and to the max
CPM prices of eligible site-targeted ads. The highest-ranking ad wins the position and is displayed %o the user.

hetps:// google.com/s fi 1 (73 of 116)8/2/2005 8:35:12 AM

When a CPC ad is displayed, mschamed only if the user clicks on the ad. A CPM ad Is charged for an impression whether clicked or not. No matter
which type of ad wins the position, the AdWords discounter monitors the competition and ensures that the winning ad is charged cnly whatis
necessary to maintain its ranking above the next-highest ad.

Site-targeted ads can appear only on the Google content network, so at pmsent mat is the only place where site-targeted and keyword-targeted ads
compete. On search results pages and other Google N prop key geted ads continue to compete as they always have.

For more on CPM pricing, see How does CPM pricing work?

When you create a site-targeted campaign, the sign-up wizard will give you the chance to enter the
URLS of sites where you'd like your ad to run. You'll also be asked to enter terms that describe the kind
of site you're looking for.

If the URLSs you enter are part of the Google content network, you'll be able to select them for your ads. (If
not, you'll see a message telling you that they're not available.) The AdWords system will also use the sites
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and terms you enter to generate a list of other Google content network sites that may be a good fit for your
ads.

The final choice of sites is entirely up to you. Remember that with site targeting, your ad will run only on
sites which are part of the Google content network, and only on the individual sites you specify.

Site-targeted campaigns can include text ads, image ads, or both. Site-targeted ads appear in the same
format sizes and the same page positions as standard keyword-targeted ads.

After setting your advertising goals for a site-targeted campaign, the next step is to select the sites where
your ad will appear. Here are some keys to creating an effective site list:

1. List the sites where you know you'd like to advertise.
2. Expand your site list.

3. Group your sites by theme.

4.create your campaign and your final list.

PON=

Step 1: List your preferred sites.

These are the sites where you already know you'd like to advertise. When you create your campaign
you'll enter these sites and then have the chance to see and select all those that are part of the Google
content network.

Step 2: Expand your site list. .

If you know of only a few sites (or no sites) where you'd like to advertise, list some sites you like on topics
that relate to what you're looking for. When you create your campaign the AdWords system can use those
sites to generate a list of Google content network sites where you may want to advertise.

Step 3: Group your sites by theme.

Review your list and look for themes within the overall list. Consider creating separate Ad Groups with
highly specific ads for each of these smaller groupings. The more precisely you target your audience, the
better chance of success your ad will have.

Step 4: Create your campaign and select your finaf sites.

When you create your campaign, the set-up wizard will include a segment for identifying and selecting sites.
As a first step you'll enter all or part of your site list. We recommend that you enter multiple site URLSs, to
give the system the broadest possible view of your interests. The wizard will generate a list of the most
closely related sites in the Google content network. Then you'll be able to select your final site list from all
these available sites.

Site-targeted ads appear only on websites that are part of the Google
content network. This includes many advertisers, large and small, who run
AdWords ads on their content sites.

Site-targeted ads aren't eligible to appear on the Google search network, on
search resulls on Google.com, or on related Google properties like Gmail. If you'd
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like to appear in these locations, we suggest running a keyword-targeted
campaign.

//adwords google comv: t/bavindex. py Hulldump=1 (74 of 116)8/22005 8:35:12 AM

Site-targeted ads require a max CPM price of US$2.00 per 1000 impressions. You may, of course, set
a higher amount. A higher max CPM increases the likelihood that your ad will appear regularly on
your selected site(s).

The Google content network consists of thousands of sites of all types, large and small, professional and
personal. Because the roster of sites grows and changes day by day, we can't publish a list of sites. The
best way to check for an individual site is to enter it in the sign-up wizard while creating a site-targeted
campaign. If that site is available, it will be listed for you to select as a target site for your campaign.

$2.00 USD, or the local currency equivalent, s the lowest max CPM that advertisers can set.

When you create a site-targeted AdWords campaign, you'll see the system's estimate of the maximum
impressions available per day for the sites you've selected. This is marked as 'Max. impressions / Day' in
the signup process.

Because site impressions vary from day to day based on many factors, the AdWords system can't predict
the number of impressions that a given site will have each day. Instead, the maximum impressions per day
offers an estimated total of the available impressions for all the sites you've selected. This may help you
decide if you have selected enough sites to satisfy your advertising goals.

Note that the impressions per day is an estimate of the total page views for those sites — not the number
of impressions your ad wilt receive. Your ad's total impressions will depend on your CPM pricing, the
popularity of the site with other site-targeted and keyword-targeted ads, and other factors.

All AdWords advertisers now have the option of creating site-targeted campaigns. However, we anticipate
that many advertisers will continue to prefer traditional keyword-targeted campaigns. if you are already
running keyword-targeted campaigns, you don't need to take any action — your ads will continue running as
they have been.

To leam how to create a site-targeted campaign in your existing account, please see this FAQ.

Keyword-targeted campaigns allow you to choose the keywords that will trigger your ads. Keyword-targeted
ads can appear on Google.com, on Google search partner sites, and on content and partner sites in the
Google Network. Keyword-targeted ads are priced on a cost-per-click (CPC) basis: you set the price you'd
like to pay each fime a user clicks on your ad, and you pay only when the ad generates a click.
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With site-targeted ads, you select the exact content sites on the Google Network where you'd like your ad to
appear. (Site-targeted ads don't appear on Google.com or on search partner sites.) Pricing for site-targeted
ads is cost-per-impression, or CPM: you set the price you'd like to pay for each 1000 impressions, and you
pay for each impression whether a user clicks on your ad or not.

Both keyword-targeted and site-targeted campaigns are available to all AdWords advertisers. Each
can include image ads, though image ads also appear only on content sites in the Google Network.

Yes. Any individual campaign can contain only site-targeted or only keyword-targeted ads and Ad Groups.
But you can run both site-targeted and keyword-targeted campaigns in your account at the same time.

PM on the Ad Group level of your campaigns. Here's how:

. Log in to your AdWords account at http:/fadwords.google.com.

- On the Campaign Summary page, click the name of the appropniate site-targeted
campaign

- Click the name of the Ad Group you want to edit.

. Click 'Edits Sites and CPMs' (located above the graph).

. Set your new maximum CPM.

. Click 'Save.’

The site tool helps you find and choose the Google Network sites where your site-targeted ads may run.

The site tool has two parts. In the Identify Sites stage, you describe your site and the kind of sites where
you'd like to advertise. In the Choose Sites stage, you select your actual target sites from a list of
candidates presented by the AdWords system.

To identify your sites, follow these steps on the first page of the site tool:

1. 1 In the left-hand box, titled Sites, enter the URLs of any websites where you'd like your ad
to appear. At this stage, don't worry about whether the site is part of the Google Network or not.
2. 2 In the right-hand box, titted Descriptive Terms, enter single words which describe your site.

3.Click 'Continue.' The URLs and descriptive terms you enter will be analyzed by the AdWords system
and then used to generate a full list of available Google Network sites. Enter as many URLs and terms as
you can: the more details you provide, the better the system will understand the kind of site you're looking
for.

Once you click "Continue,’ you'll see the Choose Sites page, with a list of available Google Network sites
that match the details you entered.

A site must be part of the Google Network [?] to be listed as a candidate. if you request a site that's not
part of the Google Network, you'll see it listed under ‘'View unavailable sites.’ (For more details, see Why
is the site 1 want not available?)

Now it's time to choose your target sites:

1. 1. Check the box next to all sites where you'd like to advertise.
2. 2. Click "Add’ to move those choices to your list of selected sites.
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3. 3. Now dlick the 'Refresh candidate sites' button. The system will analyze your choices and
create a refined list of candidates.

4. 4. Select and add more sites from the new candidate list. Click 'Refresh candidate sites’ again.

5. 5. Repeat until you're happy with your final list of sites.

6. Click "Continue' to continue setting up your campaign. Each time you hit 'Refresh,’ the AdWords
system analyzes the selections you've already made and uses them to find related or similar sites. Then it
presents these sites for your consideration.

Of course, we can't guarantee that your ad will run on every site you pick. Some sites have a limited
amount of ad space available, and you will be competing with other advertisers. Some sites may not run
certain ad formats (like banners or wide skyscrapers) or may halt advertising for other reasons. We
suggest you experiment with several different sites over time and look for the combinations that work for
you.

An individual site must be part of the Geogle Network in order o be available for your site-targeted campaign.
Being part of the Google Network means the site has agreed to run ads provided by Google, which in tum allows
your AdWords ad to compete for that space.

The site must also be a content site in order to be available for site-targeted campaigns. Some sites on the
Google Network run ads only on search results pages, which can't be selected for sile targeting. If you'd fike your
ads to appear alongside search resudts, or in related products fike Gmall, try running a keyword-targeted
campaign.

X is 2¥so possibie that ihe site you setected may have opted aut of site targeling. Some pubfishers, for reasons
of their own, prefer not to run site-targeted ads.

AdWords quality commitment : AdWords poficies & security

=) (76 of 116)8/2/2005 8:35:12 AM

As a provider of space for advertisements, we cannot arbitrate disputes bet advertisers and trademark owners. As stated in our

Terms and Conditions, advettisers are responsible for the keywords and ad content that they choosa to use. We encourage trademark owners to
resolve their disputes direcly with our advertisers, particularly because the advenisers may have similar advertisements on other sites.

As a courtesy, we are willing to perform a limited investigation of reasonable complaints. Please note that any such investigation will only affect ads
.served on or by Google. Trademark claims can be filed at any time. The trademark owner is not required to be a Google AdWords advertiser in order
1o file a claim.

To leam more about Google'’s trademark poficy and how to submit a trademark complaint, please review our full trad rh plalnt pi d

i i

As part of our ongoing effort to improve the Google AdWords program for advertisers and
users, we may periodically update the AdWords Terms and Conditions. All AdWords
advertisers are required to accept these new Terms and Conditions in order to advertise with
the AdWords program.

You may have received an email from us, or a notification within your account, requesting that
you log in and accept our new Terms and Conditions. You can do so by fogging into AdWords.

Please note that you'll have a limited amount of time (generally 30 days from your initial
notification) to log in and accept the new program Terms and Conditions; otherwise, we'll need to
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pause your account until you've made this change. To avoid interruption of your AdWords
advertising, we recommend that you log in and make this change as soon as possibie.

The Google AdWords Editorial Guidelines, posted on the Google AdWords website, define the
criteria all

ads must meet in order to run on Google. These guidelines focus on helping you to create clear,
effective, and informative ads in order to meet your sales goals. Please review the Editorial
Guidelines before creating your ads.

Please note that in the cases where minor changes to your ad are required in order to comply
with our Editorial Guidelines, a client service representative may edit your ad for you. This
prevents your ad from being disapproved and lets your ad continue to run.

Here are a few examples of edits we may make for you:

-Removing an exclamation point
.Removing or adding an extra space
.Fixing a spelling error

Google shall not be responsible in the event that a change is not made to your ad text and a
disapproval results. Therefore, it is important for you to follow the Editorial Guidelines to help
ensure that your ads continue running.

We allow affiliates to use AdWords advertising. Please note that we'll only
display one ad per search query for advertisers sharing the same top-
level domain in the Display URL. This means that if you're an affiliate
advertiser, your ad may not show for a query because another affiliate or
the website that runs the affiliate

program also has ads using the same (or a similar) domain in the

Display URL. Also, your site should not mirror (be similar or nearly
identical in appearance to) your parent company’s or another

advertiser's site.

For example, for the domain google.com, we would determine the
following URLs and Display URLSs to be equivalent:

-home.google.com
-www.google.com
.google.com
www.google.com/home
www.Google.com

s google.com/supportbin/index py?fulldump=1 (77 of 116)8/2/2005 8:35:12 AM
However, we'd determine the following Display URLSs to be distinct, since each has a
different top-level domain:

-www.google.co.uk™
-www.google.fr
www.google.com
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.www.google edu

*Domains with a country-specific extension are considered distinct.

For more information about this change, please review the January 2005 Google
AdWords service announcement.

Helpful Definitions:
Display URL

This is the URL displayed on your ad to identify your site {o users. This URL displayed is limited
to 35 characters; it need not be the same as the URL your ad links to, but it should be an actual
URL that is part of your site.

Domain

Website domains are a naming procedure by which web users may identify a particular website
address and location (e.g.. www.google.com). They are usually made up of two parts: a name
and a category. The following are common URL domain categories: .com {(commercial), .edu
(education), and .gov (government). Domain categories can also be country-specific, for example:
fr (France) , .br (Brazil), or .jp (Japan). In some cases, one category is appended to another
category, for example: examplename.co.uk, examplename.com.ph, examplename.org.uk).

What s vivsccapizblel Content™”

In order to ensure that AdWords ads benefit our users, advertisers, partners, and Google, we
maintain high standards for ads accepted into the AdWords program. For a list of affected
products and topics, please see our Content Policy. Application of content policies will always
involve an element of discretion, and we reserve the right to reject or approve any ads.

All AdWords ads are reviewed by our support staff to make sure they meet Google's guidelines.

" Ads may be disapproved for various reasons, including misspellings, inappropriate content,
unacceptable phrases like 'Click here,’ or other details which can make ads confusing, offensive
or ineffective.

When an ad does not meet Google's guidelines, we temporarily block the ad from running and
send you an email explaining why. You'll also see the word 'Disapproved’ next to any such ad in
the Campaign Management section of your AdWords account. To get the ad running, just
make the appropriate edits and save your changes. Your ad will be automatically resubmitted to
us for review.

For more details, please review the Editorial Guidelines and Content Policy.

As of May 2004, all online pharmacy-related ads and keywords for U.S.-
targeted campaigns must be associated with a valid SquareTrade ID.
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Make sure you're prepared.

Learn more about the Google Online Pharmacy Qualification Program.

hispsadwords. google. infindex py?flldump=1 (78 of 116)8/2/2005 8:35:12 AM

TP

Already a member of the SquareTrade Licensed Pharmacy Program?
Submit your SquareTrade ID in your AdWords account.

Don’t yet have a SquareTrade ID?
Leamn more and submit an application.

Not an online pharmacy or pharmacy affiliate?

Let us know. If you feel that this policy does not apply to you, please send us an exception
request through your AdWords account. You'll be notified by email when we've reviewed your
account.

Based outside of the U.S. or Canada?

The SquareTrade program is only open to pharmacies based in the U.S. or Canada. If you
are based outside of these countries, you must edit your AdWords location targeting list to
remove the U.S.

AdWords doesn't allow unusual spellings, double exclamation points or other visual gimmicks.
Our goal is to provide users with useful, relevant ads in a format that is easy to read and
understand.

Our experience shows that your ad will gather the best response if you simply describe your
product or service in a clear and straightforward way. The more you emphasize the unique
benefits of your product or service, the better your results will be.

If your business name requires unusual spelling, extra capital letters or other unigue characters,
you can request an exemption from the AdWords team when you build your ad. The AdWords
team will review and, if appropriate, approve the wording of your ad.

For more information, please see the AdWords Editorial Guidelines.

We understand that making an advertising purchase online involves a
great deal of trust on your part. We take this trust very seriously, and
make it our highest priority to help ensure the security and confidentiality
of the information you provide. Google uses industry-standard SSL
{secure socket layer) technology to protect every interaction you have
with the AdWords system. This protects your credit card and other
personal information. Once we receive your information, we not only store
it behind a firewall, but also encrypt the sensitive payment information.
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When payment information is submitted through our online form,
Google works with third-parties to verify and process your information.
Your personal information is encrypted and neither Google nor our
payment partners share or sefl your personal information. The
information you provide us will be used solely for the purpose for which
it was provided. For more details, please see our Privacy Policy.

For credit card & debit cards: Billing information is checked against the
account information by our third-

party payment processor. If the information submitted is invalid, the
payment information will not be

accepted. If the information is valid but there are discrepancies, the third-
party processor returns a fraud

score based on the number of discrepancies between the credit card
account and the AdWords account

information. High fraud scores are flagged by our system for review by
an AdWords Specialist.

For bank transfers: Google works with a third party service provider to
offer our advertisers a secure way to fund their AdWords accounts using
bank transfers in many different currencies and countries. When you pay
via bank transfer, your payments are initially sent to a bank account in
your country that belongs to this service provider, which securely
processes your payment and sends the funds to Google. Since your
payment is made to this third party, their name or the name of their local
subsidiary may appear in the bank account name to which you are
instructed to transfer your payments.

if you have any other payment or security concems, please contact us.
One of our client service specialists would be happy to answer your
questions.

Our AdWords Specialists review all of our ads to ensure that they meet Google's advertising
standards.

These standards can be found in our Terms and Conditions and in the Google AdWords Editorial
Guidelines. Google strongly believes in the importance of relevant, high-quality advertising, which
benefits both our advertisers and Google users. By creating clear, well-targeted AdWords ads,
you'll reach your potential customers more effectively and heip ensure a positive user experience
that will build users' confidence in AdWords ads. The resuit will be higher traffic to your site,
increasing the potential retum on your ad investment.

in May of 2004 we began requiring that all online pharmacy advertisers and affiliates targeting the
U.S. with their AdWords ads be a member of the SquareTrade Licensed Pharmacy program. To
be fair to all of our pharmacy advertisers, we make no exceptions. If you have not been granted a
SquareTrade seal, we are unable to show your ads in the U.S. or Canada.
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Partnering with a 3rd party to verify the credentials of online pharmacy advertising through
Google AdWords helps enhance the integrity of the online prescription drug market place as well
as the Google AdWords program. Users gain security, knowing that online pharmacies found
through Google AdWords are trustworthy. And users are more likely o complete a transaction
with a business they know they can trust.

If you are targeting the U.K_, you may not include prescription drug names in your ad text or
keyword list.

We created the Editonal Guidelines to help improve your ad campaigns as well as the Google
user experience. If we see that your ads don't follow these guidelines, we will let you know and
offer suggestions on how to improve your ads. Often, our system wiil automatically detect when
your ads should be refined. In this case, you may receive a message when you create your ads,
or you may notice a link (under the affected Ad Group in your account) to a diagnostics page
detailing the possible issues with your ads.

Our AdWords Specialists review your ads and can help you optimize your campaigns. If your ads
do not meet our guidelines or are performing poorly, we'll notify you by email. We'll often stop
running your ads until you're able to make the necessary changes. As soon as you've made and
saved the changes, your ads are automatically resubmitted to us for review.

The cookie that Google adds to a user's computer when he/she clicks on an ad expires in 30
days. This measure, and the fact that Google uses separate servers for conversion tracking and
search results, protects the user’s privacy.

Users who don't wish to participate in tracking activities can easily not accept this cookie by
setting their Intemet browser user preferences. These users will simply not be included in your
conversion tracking statistics.

Google is committed to providing an optimal user experience as well as
giving you the most effective online advertising possible. To do this, we
need the help of both our advertisers and users. if you're an advertiser,
you can help by creating concise, informative, and well-targeted ads.
Since such ads often generate the highest clickthrough rates (CTRs),
you'll see campaign performance improvements, and our users will see
useful, informative ads.

Google is not responsible for advertisers' websites including, but not
limited to maintenance of such web sites, order entry, payment
processing, shipping, cancellations, retums, or customer service.
However, we value customer service and hope that our advertisers
provide quality services. If poor service is rendered by one of our
advertisers, suggest that you contact the Better Business Bureau or
Consumer Affairs division of the city where the company is located, as
they will be able to investigate your case and act on your behalf.

‘hitps://adwords.google com/support/binfindex py Hulldump=1 (80 of 1 16)8/2/2005 8:35:12 AM
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Such organizations provide the most effective forum for addressing cases of consumer
dissatisfaction.

Yes. Google's security standards are stringent; we use data encryption and secure servers, and
do not collect or store personal information. In addition, only those pages containing the Google
conversion code are tracked.

Google is firmly committed to the privacy of our advertisers and users. While Google does add a
cookie to a user's computer when he/she dlicks on an ad, this cookie expires in 30 days, and
Google does not associate a user’s search activity with his/her ad click history. Further, Google
does not collect or track personally identifying information, and does not reveal individual
information to third parties.

Users who do not wish to participate in tracking activities can easily disable Google's
conversion tracking cookie in their Intemet browser’s user preferences settings. These users
will not be included in your conversion tracking statistics.

For more information on Google's privacy policy, please click here.

No. The information you provide will only be used by Google, and only in our efforts to serve you
better. We will not share your personal information, unless required to resolve a charge dispute or
by legal process. Please also see our Privacy Policy and Terms and Conditions.

We understand that making an advertising purchase online involves a great deal of trust on your
part. We take this trust very seriously, and make it our highest priority to ensure the security and
confidentiality of the information you provide. Google uses industry-standard SSL (secure socket
layer) technology to protect every interaction you have with the AdWords system. This protects
your credit card and other personal information. Once we receive your information, we not only
store it behind a firewall, but also encrypt the sensitive credit card information.

When credit cards are submitted through the secure online form, they are checked against the
account information by our third-party credit card processor. If information submitted is invalid, the
credit card will not be accepted. If the information is valid but there are discrepancies, the third-
party credit card processor retums a fraud score based on the number of discrepancies between
the credit card account and the AdWords account information. High fraud scores are flagged by
our system for review by an AdWords Specialist.

AdWords quality commitment : AdWords click quality

Google's proprietary technology analyzes clicks to determine whether
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